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Preface

How to Use This Guide

Purpose of  The Applied Biosystems AmpF&TR® SEfiler Plus™ PCR

This Guide Amplification Kit User Guide provides information about the
Applied Biosystems instruments, chemistries, and software
associated with the AmpF(STR® SEfiler Plus™ PCR Amplification
Kit.

Pull-Out Chapters This guide is designed to allow users to pull out chapters 2, 3, and 4.
The pull-out chapters have title and back pages, which indicate the
chapter and number title.

Text Conventions  This guide uses the following conventions:

* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

» [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.

Right-click the sample row, then select View Filter »
View All Runs.

User Attention  Two user attention words appear in Applied Biosystems user
Words documentation. Each word implies a particular level of observation
or action as described below:

Note: — Provides information that may be of interest or help but is
not critical to the use of the product.

IMPORTANT! — Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.
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Safety

Safety Alert
Words

Chemical Hazard

Warning

Examples of the user attention words appear below:
Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you
need a valid user ID and password.

Four safety alert words appear in Applied Biosystems user
documentation at points in the document where you need to be aware
of relevant hazards. Each alert word-IMPORTANT, CAUTION,
WARNING, DANGER-implies a particular level of observation or
action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

A (O7.\I[0]\] — Indicates a potentially hazardous situation that, if
not avoided, may result in minor or moderate injury. It may also be
used to alert against unsafe practices.

A \WLGINNel — Indicates a potentially hazardous situation that,

if not avoided, could result in death or serious injury.

—

A pZ\Ne]35] — Indicates an imminently hazardous situation that,
if not avoided, will result in death or serious injury. This signal word
is to be limited to the most extreme situations.

AWARNING CHEMICAL HAZARD. Some of the chemicals
used with Applied Biosystems instruments and protocols are
potentially hazardous and can cause injury, illness, or death.

vi
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Chemical Safety  To minimize the hazards of chemicals:

Guidelines * Read and understand the Material Safety Data Sheets (MSDSs)
provided by the chemical manufacturer before you store, handle,
or work with any chemicals or hazardous materials. (See “About
MSDSs” on page vii.)

* Minimize contact with chemicals. Wear appropriate personal
protective equipment when handling chemicals (for example,
safety glasses, gloves, or protective clothing). For additional
safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical
containers open. Use only with adequate ventilation (for
example, fume hood). For additional safety guidelines, consult
the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill
occurs, follow the manufacturer’s cleanup procedures as
recommended in the MSDS.

* Comply with all local, state/provincial, or national laws and
regulations related to chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets
(MSDSs) with shipments of hazardous chemicals to new customers.
They also provide MSDSs with the first shipment of a hazardous
chemical to a customer after an MSDS has been updated. MSDSs
provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous
chemical, be sure to replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is
MSDSs available to you free 24 hours a day. To obtain MSDSs:

1. Go to docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:

a. Enter the chemical name, part number, or other information
that you expect to appear in the MSDS of interest.

b. Select the language of your choice.
c. Click Search.

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide vii
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Chemical Waste

Hazards

3. To view, download, or print the document of interest:
a. Right-click the document title.

b. Select:
* Open — To view the document

» Save Target As — To download a PDF version of the
document to a destination that you choose

* Print Target — To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search
Results page:

a. Select Fax or Email below the document title.

b. Click RETRIEVE DOCUMENTS at the end of the
document list.

c. Enter the required information.

d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied
Biosystems, contact the chemical manufacturer.

A (o7:\01j[e))]1 HAZARDOUS WASTE. Refer to Material

Safety Data Sheets and local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes

produced by Applied Biosystems instruments are potentially
hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never

collect or store waste in a glass container because of the risk of
breaking or shattering. Reagent and waste bottles can crack and leak.
Each waste bottle should be secured in a low-density polyethylene
safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

viii
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Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines

Read and understand the Material Safety Data Sheets (MSDSs)
provided by the manufacturers of the chemicals in the waste
container before you store, handle, or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary
waste container holds the immediate waste. A secondary
container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container
storage.)

Minimize contact with chemicals. Wear appropriate personal
protective equipment when handling chemicals (for example,
safety glasses, gloves, or protective clothing). For additional
safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical
containers open. Use only with adequate ventilation (for
example, fume hood). For additional safety guidelines, consult
the MSDS.

Handle chemical wastes in a fume hood.

After emptying the waste container, seal it with the cap
provided.

Dispose of the contents of the waste tray and waste bottle in
accordance with good laboratory practices and local,
state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the
instrument, you must:

Characterize (by analysis if necessary) the waste generated by
the particular applications, reagents, and substrates used in your
laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred,
transported, and disposed of according to all local,
state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require
special handling, and disposal limitations may apply.
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Biological Hazard &WARNING BIOHAZARD. Biological samples such as

Safety tissues, body fluids, infectious agents, and blood of humans and other
animals have the potential to transmit infectious diseases. Follow all
applicable local, state/provincial, and/or national regulations. Wear
appropriate protective equipment, which includes but is not limited
to: protective eyewear, face shield, clothing/lab coat, and gloves. All
work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment
devices). Individuals should be trained according to applicable
regulatory and company/institution requirements before working
with potentially infectious materials. Read and follow the applicable
guidelines and/or regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines
published in Biosafety in Microbiological and Biomedical
Laboratories (stock no. 017-040-00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards,

Bloodborne Pathogens (29 CFR§1910.1030;
www.access.gpo.gov/nara/cfr/waisidx_01/
29¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for
working with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov
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How to Obtain More Information

How to Obtain More Information

Related To obtain any of the following documents, go to
Documentation www.appliedbiosystems.com, then click the links for
Support » Product and Service Literature.

Part
Document Number
Applied Biosystems 3130/3100x! Genetic Analyzers Using Data Collection Software 4363787
v3.0 User Bulletin
Applied Biosystems 3130/3130xI Genetic Analyzers Getting Started Guide 4352715

Applied Biosystems 3130/3130x/ Genetic Analyzers Maintenance, Troubleshooting, and 4352716
Reference Guide

Applied Biosystems 3130/3130xI Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems 3130/3130xI Genetic Analyzers AB Navigator Software 4359472
Administrator Guide

ABI Prism® 3100/3100-Avant Data Collection v2.0 User Guide 4347102
ABI PrisM® 3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 4350218
User Bulletin

ABI PrisM® 3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834
ABI PrisM® 3100-Avant Genetic Analyzer User Guide (Data Collection v1.0) 4333549

ABI PrisM® 3100/3100-Avant Genetic Analyzers Protocols for Processing AmpF&TR® 4332345
PCR Amplification Kit PCR Products User Bulletin

ABI PrisM® 310 Genetic Analyzer User Guide (Windows NT) 4317588
New Features and Installation Procedures for GeneMapper® ID Software V3.2 User 4352543
Bulletin

GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523

GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide 4338775

Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® Y Human 4344790
Male DNA Quantification Kit User’s Manual

GeneMapper® ID Software v3.2.1 Patch User Bulletin 4382255

Note: For additional documentation, see “How to Obtain Support”
on page Xii.
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Send Us Your Applied Biosystems welcomes your comments and suggestions for
Comments improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting
comments and suggestions relating to documentation. To order
documents, download PDF files, or for help with a technical
question, go to www.appliedbiosystems.com, then click the link for
Support. (See “How to Obtain Support” below).

How to Obtain Support

For the latest services and support information for all locations,
go to www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:
* Access worldwide telephone and fax numbers to contact
Applied Biosystems Technical Support and Sales facilities.
» Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates
of analysis, and other related documents

* Download PDF documents
* Obtain information about customer training
» Download software updates and patches

Xii AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide
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Chapter 1 Overview

Product Overview

Purpose

Product
Description

About the
Primers

The AmpF(STR® SEfiler Plus™ PCR Amplification Kit is a short
tandem repeat (STR) multiplex assay that amplifies 11
tetranucleotide repeat loci, including the SE33 locus required
specifically for the German DNA database. The kit simultaneously
coamplifies the seven loci of the European Standard Set (ESSL)
(D3S1358, vWA, D8S1179, THO1, FGA, D21S11, and D18S51), the
Amelogenin locus, the highly polymorphic SE33 (ACTBP2) locus,
and the D2S1338, D16S539, and D19S433 loci. The AmpF(STR
SEfiler Plus Kit has been developed to deliver improvements in
performance over the original SEfiler Kit. Changes to the kit include
modified PCR cycling conditions for enhanced sensitivity, a new
buffer formulation to improve performance with inhibited samples,
improvements in synthesis and purification of the amplification
primers, and a redeveloped allelic ladder.

The SEfiler Plus kit contains all the necessary reagents for the
amplification of human genomic DNA.

The reagents are designed for use with the following
Applied Biosystems instruments:

* Applied Biosystems 3130/3130x/ Genetic Analyzer

+ ABI PrisM® 3100/3100-4vant Genetic Analyzer

+ ABI PrisM® 310 Genetic Analyzer

+ Silver 96-Well GeneAmp® PCR System 9700
Gold-plated silver block GeneAmp® PCR System 9700

The AmpF(STR® SEfiler Plus™ kit contains the same loci and primer
sequences as the SEfiler™ kit but uses improved synthesis and
purification processes to minimize the presence of dye-labeled
artifacts. Modifications made in the production of VIC® and PET®
dye-labeled primers have greatly minimized the occurrence of the
120 VIC dye artifact as well as the PET dye-labeled artifacts
observed at approximately 105 to 115 bp.

1-2
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Product Overview

Loci Amplified by
the Kit

Table 1-1 shows the loci amplified by the AmpF(STR® SEfiler Plus™
kit, their chromosomal locations, and the corresponding fluorescent
marker dyes. The AmpF(STR® SEfiler Plus™ Allelic Ladder is used
to genotype the analyzed samples. The alleles contained in the allelic
ladder, and the genotype of the AmpF{STR Control DNA 007, are
also listed in the table.

Table 1-1 AmpF(STR® SEfiler Plus™ Kit loci and alleles
AmpF(STR® | AmpF(STR®
Locus Chromosome Dye Allelic Control
Designation Location Label Ladder DNA 007
Alleles Genotype
D2S1338 2935-37.1 6-FAM™ | 15, 16, 17, 20, 23
18, 19, 20,
21, 22, 23,
24, 25, 26,
27,28
D3S1358 3p 6-FAM 12,13, 14, 15,16
15,16, 17,
18,19
D8S1179 8 VIC 8,9,10,11, | 12,13
(in some 12,13, 14,
references, 15, 16, 17,
designated 18, 19
as D6S502)
D16S539 16924-qter 6-FAM 5,8,9,10, 9,10
11,12, 13,
14,15
D18S51 18921.3 PET 7,9, 10, 12,15
10.2, 11,12,
13,13.2, 14,
14.2,15, 16,
17,18, 19,
20, 21, 22,
23, 24, 25,
26, 27
AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide 1-3
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Overview

Table 1-1

AmpF(STR® SEfiler Plus™ Kit loci and alleles

Locus
Designation

Chromosome
Location

Dye
Label

AmpF(STR®
Allelic
Ladder
Alleles

AmpF(STR®
Control
DNA 007
Genotype

D19S433

19912-13.1

NED

9,10, 11,
12,12.2,13,
13.2, 14,
14.2, 15,
15.2, 16,
16.2, 17,
17.2

14,15

D21S11

21qg11.2-g21

PET

24,24.2,25,
26, 27, 28,
28.2, 29,
29.2, 30,
30.2, 31,
31.2, 32,
32.2, 33,
33.2, 34,
34.2, 35,
35.2, 36, 37,
38

28, 31

FGA

4928

NED

17,18, 19,
20, 21, 22,
23, 24, 25,
26, 26.2, 27,
28, 29, 30,
30.2, 31.2,
32.2,33.2,
42.2,43.2,
44.2,45.2,
46.2, 47.2,
48.2,50.2,
51.2

24,26

1-4
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Table 1-1

AmpF(STR® SEfiler Plus™ Kit loci and alleles

Locus
Designation

Chromosome
Location

Dye
Label

AmpF(STR®
Allelic
Ladder
Alleles

AmpF(STR®
Control
DNA 007
Genotype

SE33
(ACTBP2)

VIC

4.2,6.3, 8,
9,11, 12,
13, 14, 15,
16,17, 18,
19, 20, 20.2,
21,211,
21.2,22.2,
23.2,24.2,
25.2,26.2,
27.2,28.2,
29.2, 30.2,
31.2,32.2,
33.2,34.2,

17,25.2

THO1

11p15.5

NED

7,9.3

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide
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Table 1-1 AmpF(STR® SEfiler Plus™ Kit loci and alleles

AmpF(STR® | AmpF/STR®
Locus Chromosome Dye Allelic Control
Designation Location Label Ladder DNA 007
Alleles Genotype

VWA 12p12-pter 6-FAM 11,12, 13, 14,16

14, 15, 16,

17,18, 19,

20, 21, 22,

23,24
Amelogenin X: p22.1-22.3 | VIC X, Y X, Y

Y: p11.2

1-6 AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide
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Allelic Ladder Figure 1-1 shows the allelic ladder for the AmpF(STR® SEfiler
Profile Plus™ kit.

D351358 | FWA ] DI65539 [D251338

100 200 200 a0

D318 ] [(E3 ]

100 200 200 400

1800

1200

[D195433 THIT |FGa
100 200 200 a0

[DZISTT IDI8S51

100 200 200 a0

Figure 1-1 GeneMapper® ID Software plot of the AmpF(STR®
SEfiler Plus™ Allelic Ladder
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Control DNA 007  Figure 1-2 shows amplification of Control DNA 007 using the
Profile ~AmpF(STR® SEfiler Plus™ kit.

[D351358 | PA ] D165539 [D251338
100 200 300 400
3000.
2000-
1000-
. Dy " A
Bl
[DESTITS ] [EE5]

100 200 300 a0

3000

2000

1000,

Elf——
S

[D195433 1 [THOL JFGA

100 200 300 400
3000.
2000.
4000

A A,
[DEISTT ] [BI85EL

100 200 300 400
3000.
2000,
1000 1

Figure 1-2 500 pg of Control DNA 007 amplified with the
AmpF(STR SkEfiler Plus kit and analyzed on the Applied
Biosystems 3130x/ Genetic Analyzer
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Workflow Overview
Extract and Quantify DNA

Quantifiler™ Total Human DNA Quantification Kit

PCR Amplify DNA
AmpF(STR® SEfiler Plus™ PCR Amplification Kit

GeneAmp® PCR System 9700 Thermal Cycler*

* amplification should be done on silver or gold-plated silver blocks

Perform Electrophoresis

=) Hé; EL‘J

ABI PRISM® ABI PRISM® Applied Biosystems
310 Genetic Analyzer  3100/3100-Avant 3130/3130x/
Genetic Analyzer Genetic Analyzer

Analyze Data

GeneMapper® ID Software

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide 1-9
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Instrument and Software Overview

Data Collection
and Analysis
Software

Instrument and
Software
Compatibility

About
Multicomponent
Analysis

This section provides information about the data collection and
analysis software versions required to run the AmpF(STR® SEfiler
Plus™ PCR Amplification Kit on specific instruments.

The data collection software provides instructions to firmware
running on the instrument and displays instrument status and raw
data in real time. As the instrument records sample fluorescence on
the detection system hardware, the data collection software collects
the data and stores it. Information about each sample is stored in a
sample file (.fsa), which is then analyzed by the analysis software.

Operating Data
Instrument System Collection Analysis Software
4 Software
3130/3130x/* | Windows XP 3.0 GeneMapper® ID v3.2.1
3100/3100- Windows NT® | 1.1 (3100) GeneMapper ID v3.2.1
Avant 1.0 (3100-
Avant)
Windows 2000 | 2.0 GeneMapper ID v3.2.1
310 Windows XP 3.1 GeneMapper ID v3.2.1
Windows NT 3.0 GeneMapper ID v3.2.1
and
Windows 2000

T Applied Biosystems performed validation studies for the SEfiler Plus kit
using these configurations.

Applied Biosystems fluorescent multi-color dye technology allows
the analysis of multiple loci, including loci that have alleles with
overlapping size ranges. Alleles for overlapping loci are
distinguished by labeling locus-specific primers with different

colored dyes.

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide
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How
Multicomponent
Analysis Works

Multicomponent analysis is the process that separates the five
different fluorescent dye colors into distinct spectral components.
The four dyes used in the AmpF{STR SEfiler Plus PCR
Amplification Kit to label samples are 6-FAM™, VIC®, NED™, and
PET®dyes. The fifth dye, LIZ®, is used to label the GeneScan™ 600
LIZ® Size Standard.

Each of the fluorescent dyes emits its maximum fluorescence at a
different wavelength. During data collection on the Applied
Biosystems and ABI PRISM® instruments, the fluorescence signals
are separated by a diffraction grating according to their wavelengths
and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM dye emits at the shortest
wavelength and is displayed as blue, followed by the VIC dye (green),
NED dye (yellow), PET dye (red), and LIZ dye (orange).

Although each of these dyes emits its maximum fluorescence at a
different wavelength, there is some overlap in the emission spectra
between the dyes (Figure 1-3). The goal of multicomponent analysis
is to correct for spectral overlap.

Dyes
6-FAM VIC NED PET LIZ
100 | | | | |

s
2 80
S
w60
?
N 40
©
g 20 \
o i
Z 0 —

T T T T T T T T T T T LI B T T T T T T T

500 550 600 650 700

Wavelength (nm)

Figure 1-3 Emission spectra of the five dyes used in the
AmpF(STR® SEfiler Plus™ PCR Amplification Kit
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Materials and Equipment

Kit Contents and
Storage

The AmpF(STR® SEfiler Plus™ PCR Amplification Kit
(PN 4382699) contains materials sufficient to perform 200 reactions
at a 25-uL reaction volume.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpF(STR® SEfiler Plus™ Allelic Ladder, and
GeneScan'" 600 LIZ® Size Standard should also be protected from
light. Keep freeze-thaw cycles to a minimum.

Table 1-2 AmpF(STR® SEfiler Plus™ PCR Amplification Kit contents

Reagent Contents Quantity Storage
AmpF(STR® SEfiler Plus™ |Forward and reverse primers |1 tube, 15 to 25 °C on receipt,
Primer Set to amplify human DNA target |0.50 mL 2 to 8 °C after initial use
AmpF(STR® SEfiler Plus™ | Two tubes of Master Mix 2 tubes, 15 to 25 °C on receipt,
Master Mix containing enzyme, salts, 0.50 mL/tube |2 to 8 °C after initial use

dNTPs, carrier protein, and
0.05% sodium azide

AmpF(STR® SEfiler Plus™
Allelic Ladder

Allelic ladder containing 1 tube, 50 uL |45 to -25 °C on receipt,
amplified alleles (refer to 2 to 8 °C after initial use
“AmpF(STR® SEfiler Plus™ Kit
loci and alleles” on page 1-3
for a list of alleles included in
the ladder)

AmpF(STR® Control
DNA 007

0.10 ng/uL human male 1tube, 0.3 mL [2t0 8 °C
007 DNA in 0.02% sodium
azide and buffer (refer to
“AmpF(STR® SEfiler Plus™ Kit
loci and alleles” on page 1-3
for profile)

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide
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Standards for  For the AmpF(STR® SEfiler Plus™ Kit, the panel of standards needed
Samples for PCR amplification, PCR product sizing, and genotyping are:

» Control DNA 007 — A positive control for evaluating the

efficiency of the amplification step and STR genotyping using
the AmpF(STR® SEfiler Plus™ Allelic Ladder.

GeneScan™ 600 LIZ® Size Standard — A size standard used
for obtaining sizing results in the 60 to 400 nt range during use
with the AmpF{STR SEfiler Plus kit. The GeneScan 600 LIZ
Size Standard contains 36 single-stranded fragments of 20, 40,
60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250,
260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420, 440, 460,
480, 500, 514, 520, 540, 560, 580, and 600 nucleotides. This
standard has been evaluated as an internal size standard, and it
yields precise sizing results for AmpF{STR SEfiler Plus PCR
products. Order the GeneScan 600 LIZ Size Standard

(PN 4366589) separately.

AmpF(STR® SEfiler Plus" Allelic Ladder — An allelic ladder
developed by Applied Biosystems for accurate characterization
of the alleles amplified by the SEfiler Plus kit. The AmpF{STR
SEfiler Plus Allelic Ladder contains most alleles reported for

the 11 autosomal loci. Refer to “Loci Amplified by the Kit” on
page 1-3 for a list of the alleles included in the SEfiler Plus kit.

Equipment and  Tables 1-3 and 1-4 list required and optional equipment and materials
Materials Not not supplied with the SEfiler Plus kit. Unless otherwise indicated,
Included many of the items are available from major laboratory suppliers

(MLS).
Table 1-3 Equipment

Equipment

Source

Applied Biosystems 3130/3100x/ Genetic Analyzer

ABI Prism® 3100/3100-Avant Genetic Analyzer

ABI PrisM® 310 Genetic Analyzer

Contact your local
Applied Biosystems sales
representative

GeneAmp® PCR System 9700 with the Silver 96-Well block N8050001
GeneAmp® PCR System 9700 with the Gold-plated silver block 4314878
Silver 96-Well sample block N8050251
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Table 1-3 Equipment (continued)

Equipment

Source

Gold-plated Silver 96-Well sample block

4314443

Tabletop centrifuge with 96-well plate adapters (optional)

Major Laboratory Supplier
(MLS)

Table 1-4 User-supplied materials*

Material Source
AmpF(STR® SEfiler Plus™ PCR Ampilification Kit 4382699
3130/3100x/ Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3130x//3100 Genetic Analyzer Capillary Array, 36-cm 4315931
3130/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3130/3130x/ Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 600 LIZ® Size Standard 4366589
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Hi-Di™ Formamide 4311320

Guide (PN 4352716).

For a complete list of parts and accessories for the 3130/3130x/ instrument, refer to Appendix A of the
Applied Biosystems 3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference
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Table 1-4 User-supplied materials* (continued)

Material Source
3100/3100-Avant Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3130x//3100 Genetic Analyzer Capillary Array, 36-cm 4315931
3130/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 600 LIZ® Size Standard 4366589
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
250-uL Glass Syringe, (array-fill syringe) 4304470
5.0-mL Glass Syringe, (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B
of the ABI PrisM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide
(PN 4335393).

310 Analyzer materials

310 Genetic Analyzer Capillary, 47-cm 402839
0.5-mL Sample Tray 5572
96-Well Tray Adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 600 LIZ® Size Standard 4366589
Running Buffer, 10X 402824
Genetic Analyzer Septa Retainer Clips for 96-Tube Sample Tray 402866
Genetic Analysis Sample Tubes (0.5-mL) 401957
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Table 1-4 User-supplied materials* (continued)

Material Source

Septa for 0.5-mL Sample Tubes 401956

DS-33 Matrix Standard Set [BFAM™, VIC®, NED™, PET®, and LIZ® dyes] for 4318159
ABI Prism® 310/377 systems

MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 96-Well Base (holds 0.2-mL reaction tubes) N8010531
MicroAmp™ 96-Well Full Plate Cover N8010550
MicroAmp™ 96-Well Tray/Retainer Set 403081
POP-4™ Polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the
ABI PrisM® 310 Genetic Analyzer User Guide (PN 4317588).

PCR Amopilification

MicroAmp™ 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 8-Caps Strip N8010535
MicroAmp™ 96-Well Tray/Retainer Set 403081

MicroAmp™ 96-Well Base N8010531
MicroAmp™ Optical 96-Well Reaction Plate N8010560

Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol-resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
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Table 1-4 User-supplied materials* (continued)

Material Source
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

I For the Material Safety Data Sheet (MSDS) of any chemical not distributed by Applied Biosystems,
contact the chemical manufacturer. Before handling any chemicals, refer to the MSDS provided by the
manufacturer, and observe all relevant precautions.
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PCR Amplification

This chapter covers:

PCRWork Areas. .. ...t 2-2
Required User-Supplied Materials and Reagents . ............. 2-4
Quantifying DNA ... ... ... . 2-5
Preparing the Reactions. .. ............. ... ... ... ..., 2-7
Performing PCR . ... ... .. .. .. .. .. .. 2-9
Amplification Using Bloodstained FTA Cards. .............. 2-10
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Chapter 2 PCR Amplification

PCR Work Areas

Work Area Setup  Many resources are available for the appropriate design of a PCR
and Lab Design laboratory.
+ If you are using the AmpF(STR® SEfiler Plus™ PCR
Amplification Kit for forensic DNA testing, refer to Forensic
Laboratories: Handbook for Facility Planning, Design,
Construction and Moving, National Institute of Justice, 1998
(www.nij.org/publications).

» If you are using the SEfiler Plus kit for parentage DNA testing,
refer to the Guidance for Standards for Parentage Relationship
Testing Laboratories, American Association of Blood Banks,
7th edition, 2004.

The sensitivity of the SEfiler Plus kit (and other PCR-based tests)
enables amplification of minute quantities of DNA, necessitating
precautions to avoid contamination of samples yet to be amplified
(Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent
contamination by human DNA. Wear gloves at all times and change
them frequently. Close sample tubes when not in use. Limit aerosol
dispersal by handling sample tubes and reagents carefully.

Note: Applied Biosystems does not intend these references for
laboratory design to constitute all precautions and care necessary for
using PCR technology.

PCR Setup Work IMPORTANT! These items should never leave the PCR Setup Work
Area Area.
» Calculator
* Gloves, disposable
* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate
clean tube (for Master Mix preparation)

* Microcentrifuge tube rack

+ Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

» Tube decapper, autoclavable

* Vortex
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Amplified DNA  The following GeneAmp® PCR Systems should be placed in the
Work Area Amplified DNA Work Area.

+ Silver block 96-Well GeneAmp® PCR System 9700
+ Gold-plated silver block GeneAmp® PCR System 9700
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Required User-Supplied Materials and Reagents

Kit Contents and
Storage

User-Supplied
Reagents

Each AmpF(STR® SEfiler Plus™ PCR Amplification Kit contains
materials sufficient to perform 200 reactions at a 25-uL reaction
volume. See “Kit Contents and Storage” on page 1-12 for details on
SEfiler Plus kit contents.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpF(STR® SEfiler Plus™ Allelic Ladder, and
GeneScan'" 600 LIZ® Size Standard should also be protected from
light. Minimize freeze-thaw cycles.

In addition to the SEfiler Plus kit reagents, the use of low TE buffer
(10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can
prepare the buffer as described in the following table or order it from
Teknova (Cat # T0223).

To prepare low TE buffer

1. | Mix together:

* 10 mL of 1 M Tris-HCI, pH 8.0

* 0.2mL of 0.5 M EDTA, pH 8.0

* 990 mL glass-distilled or deionized water

AWARNING CHEMICAL HAZARD. EDTA. Exposure

causes eye irritation. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and
gloves.

Note: Adjust the volumes accordingly for specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.
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Quantifying DNA

Importance of
Quantitation

Methods for
Quantifying DNA

Quantifying the amount of DNA in a sample before amplification
allows you to determine whether or not sufficient DNA is present to
permit amplification and to calculate the optimum amount of DNA to
add to the reaction. The optimum amount of DNA for the SEfiler
Plus Kit is 0.50 to 0.75 ng in a maximum input volume of 10 pL.

If too much DNA is added to the PCR reaction, then the increased
amount of PCR product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for
detection by the instrument (“off-scale” data).
Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not
accurate. For example, an allele peak that is off-scale can
cause the corresponding stutter peak to appear higher in
relative intensity, thus increasing the calculated percent
stutter.

— Multicomponent analysis of off-scale data is not accurate, and
it results in poor spectral separation (“pull-up”).

* Incomplete A nucleotide addition.

When the total number of allele copies added to the PCR is extremely
low, allelic dropout can occur resulting in a partial profile.

Applied Biosystems provides several kits for quantifying DNA in
samples. See the reference cited in Table 2-1 on page 2-6 for details
about these kits.
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Table 2-1 Methods for quantifying DNA
Product Description References
Quantifiler® Y Human Properties: Quantifiler® Human

Male DNA
Quantification Kit
(PN 4343906)

Quantifiler® Human
DNA Quantification Kit
(PN 4343895)

* Both Quantifiler® kits have high specificity
for human DNA. The Quantifiler® Y kit is
highly specific for human male DNA.

* The kit detects single-stranded and
degraded DNA.

How it works:

The DNA quantification assay combines two
5’ nuclease assays:

e A target-specific (human DNA or human
male DNA) assay, which consists of two
primers for amplifying human or human
male DNA and one TagMan® MGB probe
labeled with FAM™ dye for detecting the
amplified sequence

¢ Aninternal PCR control (IPC) assay, which
consists of an IPC template DNA (a
synthetic sequence not found in nature),
two primers for amplifying the IPC template
DNA, and one TagMan MGB probe labeled
with VIC® dye for detecting the amplified
IPC DNA

DNA Quantification Kits
User’s Manual
(PN 4344790)

2-6
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Preparing the Reactions

SEfiler Plus Kit  To prepare the reactions

Reactions

1.

Calculate the volume of each component needed to prepare
the reactions, using the table below.

Volume Per

Component Reaction (uL)
AmpF(STR® SEfiler Plus™ Master Mix 10.0
AmpF(STR® SEfiler Plus™ Primer Set 5.0

Note: Include additional reactions in your calculations to
provide excess volume for the loss that occurs during reagent
transfers.

Prepare reagents. Thaw the AmpF(STR® SEfiler Plus™
Master Mix and the AmpF¢STR® SEfiler Plus™ Primer Set,
then vortex the mix and primer set 3 seconds and centrifuge
them briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of
the kit. After first use, reagents are stored at 2 to 8 °C and,
therefore, do not require subsequent thawing. Do not
refreeze the reagents.

Pipette the required volumes of components into an
appropriately sized polypropylene tube.

Vortex the reaction mix for 3 seconds, then centrifuge
briefly.

Dispense 15 UL of the reaction mix into each reaction well of
a MicroAmp"" Optical 96-Well Reaction Plate or each
MicroAmp® Reaction Tube.
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To prepare the reactions (continued)

6. Prepare the DNA samples:

DNA Sample To Prepare...

Negative Control Add 10 pL of low TE buffer.

Your Sample Dilute a portion of your DNA sample
with low TE buffer so that 0.50 to
0.75 ng of total DNA is in a final
volume of 10 uL. Add your sample to
the reaction mix.

Positive Control Combine 5 pL of control DNA

(0.1 ng/uL) with 5 L of low TE buffer
for a total volume of 10 uL. (The final
sample concentration is 0.05 ng/uL.)
Add to the reaction mix.

Note: The final reaction volume should be 25 pL.

7. | Centrifuge the plate at 3,000 rpm for about 20 seconds in a
tabletop centrifuge with plate holders to remove any bubbles.

8. Amplify the DNA in a Silver block 96-Well GeneAmp® PCR
System 9700, or a Gold-plated silver block GeneAmp® PCR
System 9700.
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Performing PCR

To run PCR

1. Set the thermal cycling conditions.

IMPORTANT! If using the Gold-plated Silver or Silver 96-Well
GeneAmp PCR System 9700, select the 9600 Emulation mode.

Initial Cycle Final Final
Incubation (30 cycles) Extension Hold

Step

De- Anneal | Extend
nature

HOLD CYCLE HOLD HOLD

95 °C 94 °C 59 °C 72 °C 60 °C 4°C

11 min 20 sec 2 min 1 min 60 min o

2.  Load the plate into the thermal cycler, then close the heated
cover.

AWARNING PHYSICAL INJURY HAZARD.

During instrument operation, the temperature of the heated
cover can be as high as 108 °C, and the temperature of the
sample block can be as high as 100 °C. Keep hands away
from the heated cover and sample block.

3. | Start the run.

4. | Store the amplified DNA.

If you are storing the DNA for... Store at...

<2 weeks 2to8°C

>2 weeks -15to 25 °C

IMPORTANT! Protect the amplified products from light.
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Ampilification Using Bloodstained FTA Cards

FTA™-treated DNA collection cards can be useful for the collection,
storage, and processing of biological samples. You can place a small
punch disk of the bloodstained card directly into an amplification
tube, purify it, and amplify it without transferring the evidence.
Applied Biosystems studies indicate that a 1.2-mm bloodstained disk
contains approximately 5 to 20 ng DNA. An appropriate cycle
number for this high quantity of DNA is 25 cycles. It is
recommended that each laboratory determine the cycle number based
on individual validation studies.

In the example shown in Figure 2-1, a 1.2-mm disk of a bloodstained
FTA card was purified using three washes with FTA Purification
Reagent and two washes with 1X TE buffer. After drying at room
temperature overnight, the punch was then amplified directly in the
MicroAmp® tube for 25 cycles.

Il flﬁ I ) it A L

Figure 2-1 AmpF(STR® SEfiler Plus™ PCR Amplification Kit
results from a 1.2-mm FTA bloodstain disk (25-cycle
amplification), analyzed on the Applied Biosystems 3130x/ Genetic
Analyzer
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Electrophoresis
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Performing Electrophoresis

This chapter covers:

Allelic Ladder Requirements . ............................ 3-2

Setting-Up the 3100/3100-A4vant or 3130/3130x/ Instrument

for Electrophoresis . ...t 33

Preparing Samples for Electrophoresis on the

3100/3100-Avant or 3130/3130x/ Instrument . . .. ............. 3-5

Setting-Up the 310 Instrument for Electrophoresis ............ 3-7

Preparing Samples for Electrophoresis on the 310 Instrument. . . .3-8
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Allelic Ladder Requirements

To accurately genotype samples, use an Allelic Ladder sample that is
run with the samples. Applied Biosystems recommends that for:

+ ABI PRISM® 310 Genetic Analyzer — Run at least one allelic
ladder for every 10 sample injections.

+ ABI PrISM® 3100 or Applied Biosystems 3130 series
instruments — Run at least one allelic ladder for each set of 16
samples.

— Applied Biosystems 3130x/ or ABI PRiSM® 3100 systems —
One ladder per injection; one injection = 16 samples (15
samples + 1 allelic ladder)

— Applied Biosystems 3130 or ABI PRISM® 3100-Avant —
One ladder for every 4 injections; one injection = 4 samples

IMPORTANT! Variation in laboratory temperature can cause changes
in fragment migration speed, which can, in turn, cause sizing
variation. Applied Biosystems recommends the above frequency of
allelic ladder injections to account for normal variation in run speed.
However, during internal validation studies, each laboratory should
verify the required allelic ladder injection frequency to ensure
accurate genotyping of all samples in each laboratory environment.

It is critical to genotype using an allelic ladder that is run under the
same conditions as the samples because:

* Size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and
electrophoretic conditions.

* Slight procedural and reagent variations between single and
multiple capillaries result in greater size variation than that
found between samples injected in the same capillary in a single
run.
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Setting-Up the 3100/3100-Avant or 3130/3130xl Instrument for Electrophoresis

Setting-Up the 3100/3100-Avant or 3130/3130x/
Instrument for Electrophoresis

Reagents and
Parts

Electrophoresis
Setup Software
and Reference
Documents

Table 1-4 on page 1-14 lists the required materials not supplied with
the AmpF(STR® SEfiler Plus™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpF(STR® SEfiler Plus™ Allelic Ladder, and
GeneScan"" 600 LIZ® Size Standard should also be protected from
light. Minimize freeze-thaw cycles.

Table 3-1 lists data collection software and the run modules that you
can use to analyze SEfiler Plus kit products. For details on the
procedures, refer to the documents listed in the table.

Table 3-1 SEfiler Plus kit: data collection software and reference
documents for use with the 3100/3100-Avant or 3130/3130x/
instruments

Operating | Data Collection

System Software Run Module References
Windows |3.0(3130/3130x/ | HIDFragmentAnalysis36_ Applied Biosystems 3130/3130x/
XP Analyzer)* POP4_1 Genetic Analyzers Using Data

¢ Dye Set G5 Collection Software v3.0,
Protocols for Processing
AmpFSTR® PCR Amplification
Kit PCR Products User Bulletin
(PN 4363787).
Windows |[2.0 ¢ HIDFragmentAnalysis36_POP4_1 | ABI PrismM® 3100/3100-Avant
2000

e Dye Set G5 Genetic Analyzers Using Data
Collection Software v2.0,
Protocols for Processing
AmpFSTR® PCR Amplification
Kit PCR Products User Bulletin
(PN 4350218)
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Analyzer)

GeneScan36Avb_DyeSetG5Module

Analysis Module:
GS600AnNalysis.gsp

Og:sr?:mg Datgocfitc‘)’:,l::etlon Run Module References
Windows | 1.1 (3100 Run Module: ABI PrisM® 3100/3100-Avant
NT® Analyzer) GeneScan36vb_DyeSetG5Module | Genetic Analyzers Protocols for
Analysis Module: Procggsing AmpF STR® PCR
GS600ANalysis g;sp Amplification Kit PCR Products
) User Bulletin (PN 4332345)
1.0 (83100-Avant | Run Module:

I Applied Biosystems performed validation studies for the SEfiler Plus kit using this configuration.

3-4
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Preparing Samples for Electrophoresis on the 3100/3100-Avant or 3130/3130x! Instrument

Preparing Samples for Electrophoresis on the
3100/3100-Avant or 3130/3130x/ Instrument

Preparing the Prepare the samples for electrophoresis on the 3100/3100-4vant or
Samples 31 30/3130x/ instrument immediately before loading.

To prepare samples for electrophoresis

1.

Calculate the volume of Hi-Di™ Formamide and GeneScan"™
600 LIZ® Internal Size Standard needed to prepare the
samples, using the table below.

Volume
Reagent per reaction (uL)
GeneScan™ 600 LIZ® Size Standard 0.6
Hi-Di™ Formamide 8.4

Note: Include additional samples in your calculations to
provide excess volume for the loss that occurs during reagent
transfers.

IMPORTANT! The volume of size standard indicated in the
table is a suggested amount. Determine the appropriate
amount of size standard based on your results/experiments.

AWARNING CHEMICAL HAZARD. Hi-Di

Formamide. Exposure causes eye, skin, and respiratory tract
irritation. It is a possible developmental and birth defect
hazard. Avoid breathing vapor. Use with adequate
ventilation. Avoid contact with eyes and skin. Read the
MSDS, and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

Pipette the required volumes of components into an
appropriately sized polypropylene tube.

Vortex the tube, then centrifuge briefly.
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To prepare samples for electrophoresis (continued)

4. Into each well of a MicroAmp"" Optical 96-Well Reaction
Plate, add:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or Allelic Ladder

Note: For blank wells, add 10 uL of Hi-Di"" formamide.

5. Seal the reaction plate with appropriate septa, then briefly
centrifuge the plate to ensure that the contents of each well
are mixed and collected at the bottom.

6. Heat the reaction plate in a thermal cycler for 3 minutes at
95 °C.

AWARNING PHYSICAL INJURY HAZARD.

During instrument operation, the temperature of the heated
cover can be as high as 108 °C, and the temperature of the
sample block can be as high as 100 °C. Keep hands away
from the heated cover and sample block.

7. | Immediately place the plate on ice for 3 minutes.

8.  Prepare the plate assembly on the autosampler.

9.  Start the electrophoresis run.
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Setting-Up the 310 Instrument for Electrophoresis

Setting-Up the 310 Instrument for Electrophoresis

Reagents and
Parts

Electrophoresis
Setup Software
and Reference
Documents

Table 1-4 on page 1-14 lists the required materials not supplied with
the AmpF(STR® SEfiler Plus™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpFISTR® SEfiler Plus™ Allelic Ladder, and
GeneScan'" 600 LIZ® Size Standard should also be protected from
light. Minimize freeze-thaw cycles.

Table 3-2 lists data collection software and the run modules that you
can use to analyze SEfiler Plus kit products. For details on the
procedures, refer to the documents listed in the table.

Table 3-2 SkEfiler Plus kit: data collection software and reference
documents for use with the 310 instrument

Operating
System

Data
Collection Run Module References
Software

Windows XP 3.1t

GS STR POP4 (1ml) G5 v2.md5 | ABI PrisM® 310 Genetic Analyzer
User’s Manual (Windows)
(PN 4317588)

ABI Prism® 310 Protocols for
Processing AmpF{STR® PCR
Amplification Kit Products with
Microsoft Windows NT Operating
System: User Bulletin

(PN 4341742)

and Windows
2000

Windows NT® 3.0

GS STR POP4 (1ml) G5 v2.md5 | ABI PrisM® 310 Genetic Analyzer
User’s Manual (Windows)
(PN 4317588)

ABI Prism® 310 Protocols for
Processing AmpFI{STR® PCR
Amplification Kit Products with
Microsoft Windows NT Operating
System: User Bulletin

(PN 4341742)

T Applied Biosystems conducted concordance studies for the SEfiler Plus kit using this configuration.
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Preparing Samples for Electrophoresis on the 310

Instrument

Preparing the Prepare the samples for electrophoresis on the 310 instrument
Samples immediately before loading.

To prepare samples for electrophoresis

L.

Calculate the volume of Hi-Di"" Formamide and GeneScan'"
600 LIZ® Internal Size Standard needed to prepare the
samples, using the table below.

Volume
Reagent per reaction (uL)
GeneScan™ 600 LIZ® Size Standard 1.0
Hi-Di™ Formamide 24.0

Note: Include additional samples in your calculations to
provide excess volume for the loss that occurs during reagent
transfers.

IMPORTANT! The volume of size standard indicated in the
table is a suggested amount. Determine the appropriate
amount of size standard based on your results/experiments.

AWARNING CHEMICAL HAZARD. Hi-Di

Formamide. Exposure causes eye, skin, and respiratory tract
irritation. It is a possible developmental and birth defect
hazard. Avoid breathing vapor. Use with adequate
ventilation. Avoid contact with eyes and skin. Read the
MSDS, and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

Pipette the required volumes of components into an
appropriately sized polypropylene tube.

Vortex the tube, then centrifuge briefly.

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide



Preparing Samples for Electrophoresis on the 310 Instrument

To prepare samples for electrophoresis (continued)

4.

Into each 0.2-mL or 0.5-mL sample tube, add:
» 25 uL of the formamide:size standard mixture
* 1.5 uL of PCR product or Allelic Ladder

Seal the tubes with appropriate septa, then briefly centrifuge
the tubes to ensure that the contents of each tube are mixed
and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95 °C.

AWARNING PHYSICAL INJURY HAZARD.

During instrument operation, the temperature of the heated
cover can be as high as 108 °C, and the temperature of the
sample block can be as high as 100 °C. Keep hands away
from the heated cover and sample block.

Immediately place the tubes on ice for 3 minutes.

Place the sample tray on the autosampler.

Start the electrophoresis run.
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Overview of GeneMapper® ID Software

What Does
GeneMapper ID
Software Do?

Instruments

Before You Start

GeneMapper® ID Software is an automated genotyping software
solution for forensic, paternity, and database data analysis and other
genotyping needs.

After electrophoresis, the data collection software stores information
for each sample in a .fsa file. Using GeneMapper /D v3.2.1 software,
you can then analyze and interpret the data.

Refer to “Instrument and Software Overview” on page 1-10 for a list
of compatible instruments.

When using GeneMapper /D Software version 3.2.1 to perform
Human Identification (HID) analysis with AmpF(STR® kits, consider
that:

» HID analysis requires at least one allelic ladder sample per run
folder. Your laboratory can use multiple ladder samples in an
analysis as long as it performs the appropriate validation studies.

For multiple ladder samples, the GeneMapper /D Software
calculates allelic bin offsets by using an average of all ladders
that use the same panel within a run folder.

 Allelic ladder samples in an individual run folder are considered
to be from a single run.

When the software imports multiple run folders into a project,
only the ladder(s) within their respective run folders are used for
calculating allelic bin offsets and subsequent genotyping.

» Allelic ladder samples need to be identified as “Allelic Ladder”
in the Sample Type column in a project. Failure to apply this
setting for ladder samples results in failed analysis.

+ Allelic bin definitions are stored in the
AmpFLSTR_SEfiler_Plus_Panels_v1 in the Panel Manager.

* Injections containing the allelic ladder must be analyzed with
the same analysis method and parameter values that are used for
samples to ensure proper allele calling.

When using GeneMapper ID-X Software version 1.0 to perform
Human Identification (HID) analysis with AmpF(STR® kits, refer to
the GeneMapper® ID-X Software Version 1.0 Human Identification
Analysis Getting Started Guide (PN 4375574).

4-2
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+ Alleles not found in the AmpF(STR® Allelic Ladders do exist.
Off-ladder alleles may contain full and/or partial repeat units.
An off-ladder allele is an allele that occurs outside the +0.5-nt
bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the
sample result needs to be verified according to the laboratory’s
protocol.

Setting Up GeneMapper® ID Software v3.2.1 for
Analyzing AmpF(STR® SEfiler Plus™ Kit Data

Overview Before you can analyze sample (.fsa) files using GeneMapper ID
Software v3.2.1 for the first time, you need to:

* Import panels and bins into the Panel Manager, as explained in
“Importing Panels and Bins” on page 4-4.

* Import an analysis method as explained in “Importing an HID
Analysis Method” on page 4-9.

* Define custom views of analysis tables.

+ Refer to Chapter 1 of the GeneMapper® ID Software Versions
3.1 and 3.2 Human ldentification Analysis Tutorial
(PN 4335523) for more information.

* Define custom views of plots.

+ Refer to Chapter 1 of the GeneMapper® ID Software Versions
3.1 and 3.2 Human ldentification Analysis Tutorial
(PN 4335523) for more information.

Note: For details about GeneMapper /D features, refer to the
GeneMapper® ID Sofiware Version 3.1 Human Identification
Analysis User Guide (PN 4338775), GeneMapper® ID Software
Versions 3.1 and 3.2 Human Identification Analysis Tutorial

(PN 4335523). Also, refer to the Installation Procedures and New
Features for GeneMapper® ID Sofiware v3.2 User Bulletin

(PN 4352543).

Note: For details about GeneMapper ID-X, refer to GeneMapper®
ID-X Software Version 1.0 Human Ildentification Analysis Getting
Started Guide (PN 4375574).
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Importing Panels  To import the SEfiler Plus kit panels and bin sets from the
and Bins Applied Biosystems web site into the GeneMapper /D software
database:

1. | a. Download the GMID_SEfiler_Plus_files.zip file
containing panels and bins from:

www.appliedbiosystems.com » Support » Software
Downloads » Select GeneMapper® ID Software v3.2 »
Updaters & Patches.

b. Unzip the file.

2. | Start the GeneMapper [D software, then log in with the
appropriate user name and password.

IMPORTANT! If you need log on instructions, refer to the
GeneMapper® ID Sofiware Version 3.1 Human Identification
Analysis User Guide (PN 4338775), page 2-7.

3. Select Tools » Panel Manager to open the Panel Manager.

4. | Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

(71 Panel Manager

File Edit Bins ‘iew

HE BEE HBE

E= Panel Manaoer

Highlight this.
|

b. Select File » Import Panels to open the Import Panels
dialog box.

c. Navigate to, then open the GMID_SEfiler_Plus_files
folder that you unzipped in step .
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5. Select AmpFLSTR_SEfiler_Plus_Panels_v1, then click
Import.

Note: Importing this file creates a new folder in the
navigation pane of the Panel Manager,
AmpFLSTR_SEfiler_Plus_Panels_v1. This folder contains
the panels and associated markers.

(] Import Panels

Lookin:  |C) GMD_SEfilr_Plus_files v # 2EE
— @ AmpFLSTR_SEfiler_Plus_Bins_w1
,J E AmpFLSTR_SEfiler_Plus_Panels_w1
Recent CE_GS_SEfiler_Plus_GSE00_HID_v1
?[-:% SEfiler_Plus_HID_v1
Desktop
‘-j File natme: | AmpFLSTR_SEfiler_Plus_Panels_v! xt | |_tmport
My Documents | Files of type: sl Files v | |_cancel
4-5
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Import AmpFLSTR_SEfiler_Plus_Bins_v1:

a.

b.

C.

d.

Select the AmpFLSTR_SEfiler_Plus_Panels_v1
folder in the navigation pane.

(7] Panel Manager
File Edit Eins ‘iew

il X M | et

I AmpFLETR_SEfiler_Plus_Panels_v1

T sEfiler _Plus_v1

Select File » Import Bin Set to open the Import Bin
Set dialog box.

Navigate to, then open the GMID_SEfiler_Plus_files
folder.

Select AmpFLSTR_SEfiler_Plus_Bins_v1, then click
Import.

Note: Importing this file associates the bin set with the
panels in the AmpFLSTR_SEfiler_Plus_Panels_v1
folder.

() Import Bin Set

Look in: |@ GMID_SEfiler_Plus_files V| I ,3||E|

Desktop
.-J File name: | AmpFLSTR_SEfiler_Plus_Bins_w1 | Import
My Documerts | Files of type: |AII Files 4 | Cancel

= B AmpFLSTR_SEfiler_Plus_Bins_v
,-J @ AmpFLSTR_SEfiler _Plus_Panelzs_w1
Recent CE_GS_SEfiler _Plus_GSE00_HID w1

?[-:% SEfiler_Plus_HID_1
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7. View the imported panels in the navigation pane:

a. Double-click AmpFLSTR_SEfiler_Plus_Panels_v1
folder to view the SEfiler_Plus_v1 folder.

b. Double-click the SEfiler_Plus_v1 folder to display the
panel information in the right pane and the markers
below it.

(7] Panel Manager

File Edit Bins Wiew
B X E W O M enset |AmpFLSTR_SEf\Ier_PIus_Eins_v1 v| == ||
~ Bakor Hame  |Dye Color | Min Size | M Size | Control Allsles
1 pas13ss blue 93.0 1480 [1518
2 |wa blug 1510 [2135 1416
VAL,
3 |D163539 blug 2280 (2790 (810
D163539
0251333 4 |D2s1338 blug 2840 (3500 (2023
AMEL 5 |AMEL Hreen 106.0 1140 R
Daz117a 6 |DES1179 green  |1180 1835 1213
SE33 7 |sE33 green (1900 (3500 17252
D195433
THOY & |D193433 yellow 1010|1480 [14.15
FGA 9 |THOY yellow 1590 (2050 |7.83
D21511 | 1o [Fea yellow |20625 (3800  [24.25
= 018551 B ¥ 41 [pzrs1 red 1845 (2475 (2831
ax 12 018551 red 26449 (3500 1215
=Reference Samples ¢ i
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8. View the markers and display the Bin view in the navigation
pane:

a. Select the SEfiler_Plus_v1 folder to display its list of
markers in the right pane.

b. Double-click the SEfiler_Plus_v1 folder to display its
list of markers below it.

c. Select D2S1338 to display the Bin view for the marker
in the right pane.

(#]Panel Manager.

File Edit Bins View

X 1E m W H M Einset ampFLSTR_SEfier_Plus_Bins_l .

= T AmpFLSTR_SEfiler_Plus_Parels_w1 &

a, b* B EDsEfler_Plus_v1 14/[15] (16 [17| (18] 180
0351358 10

WA

Das1173

= 07
D195433
THOM
Fo4
D215

1=l
o
[

018351
< | =

SIReference Sarples

00
279 267 295 303

D251338

9. Click Apply, then OK to add the SEfiler Plus panel and bin
set to the GeneMapper /D database.

IMPORTANT! If you close the Panel Manager without
clicking OK, the panels and bins are not imported into the
GeneMapper /D database.
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Importing an HID  The analysis method for the AmpF(STR® SEfiler Plus™ PCR

Analysis Method Amplification Kit uses the HID Advanced Mode Peak Detection
Algorithm. This analysis method provides users with the same
analysis parameters available in GeneScan® Software v3.7.1 for the
Windows operating system.

Use the following procedure to import the analysis method for the
SEfiler Plus kit from the folder that you downloaded from the
Applied Biosystems web site into the GeneMapper /D software
database. Refer to step 1a on page 4-4 for downloading instructions.

To import the HID Advanced Mode analysis method into
GeneMapper ID software

1. Select Tools » GeneMapper Manager to open the
GeneMapper Manager.

2. | Import an analysis method for HID_Advanced:
a. Select the Analysis Methods tab, then click Import.

_5_,' GeneMapper Manager

Projeds‘ Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards
Name Last Saved Owner Instrumert Analysis Type Descrigtion
| ShaPshot Detault 2005-03-16 16:00:3 | genicd ShlaPshaot Farctory F‘I’ﬂvldﬂ
| Y Filer 2005-03-28 06:29 4 | gmid 5100 HID )
< |
b. Navigate to, then open the GMID_SEfiler_Plus_files
folder.

3. Select SEfiler_Plus_HID_vl1, then click Import to import
the SEfiler_Plus_HID_v1 analysis method into the
GeneMapper /D database.

®llm port Analysis Method

Look in: |@GMID_SEfiIer_PIus_fiIes V| E -:,lElEl

’-J- CE_GS_SEfiler_Plus_GSE00_HID_v1

B =Efiler_Plus_HID_1

fl_-
Desktop
’j File nane: | SEfiler_Plus_HID_w1 xral | Ittt
Wy Documents | Files of type: |xn-1|_ Files £* xml) hd | Cancel
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To import the HID Advanced Mode analysis method into
GeneMapper ID software (continued)

a.

b.

Table 4-1
settings

4. | To view the settings in the SEfiler_Plus_HID_v1 analysis
method:

Select the Analysis Methods tab.

Select SEfiler_Plus_HID_v1 in the Name column,
then click Open.

Table 4-1 on page 4-10 shows the settings for each tab
of the Analysis Method Editor - HID.

SEfiler_Plus_HID_v1 Advanced Mode analysis method

Tab

Settings

General

Name: SEfiler_Plus_HID_v1

is Method Editor - HID X

1 et | Peak Detector | Peak Qualty | ualty Flags

[ Analysis Method Description

Mane: SEfiler_Plus_HID_w1

Description: SEfiler_Plus default Analysis Method version 1 )

Instrumert;

Analysis Type: HID
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Table 4-1

SEfiler_Plus_HID_v1 Advanced Mode analysis method

settings (continued)

Tab

Settings

Allele

X

Analysis Method Editor. - HID

Peak Detector | Peak Quality | Quality Flags

Bin Set: |AmpFLSTR_SEfiIer_PIus_Eiins_v1 w |
Use marker-zpecific stutter ratio if available
Marker Repest Type : Tri Tetra Perta Hexa
Cut-off Yalue oo oo oo oo
inus4 Ratio oo oo oo oo
Minuza, Distance From | 0.0 oo oo 0.0
Ta oo oo oo oo
Minuz Stutter Ratio oo oo oo oo
Minus Stutter Distance  From | 0.0 325 oo 0.0
Ta oo 475 oo oo
Plus Stutter Ratio oo oo oo oo
Plus Stutter Distance From | 0.0 oo oo 0.0
Ta oo oo oo oo
Amelogenin Cutoff

Range Filter ... Factory Defaults

¢ GeneMapper® ID Software v3.2.1 allows you to
specify four types of marker repeat motifs: tri, tetra,
penta, and hexa. You can enter parameter values for
each type of repeat in the appropriate column.

¢ The “Use marker-specific stutter ratio if available”
check box is selected by default. Consequently, the
software applies the stutter ratio filters supplied in the
AmpFLSTR_SEfiler_Plus_Panels_v1 file.

Note: For more information about allele filters, refer to
the GeneMapper® ID Software Version 3.1 Human
Identification Analysis User Guide, Chapter 3

(PN 4338775) and the Installation Procedures and New
Features for GeneMapper® ID Software Version 3.2 User
Bulletin (PN 4352543).
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Table 4-1

SEfiler_Plus_HID_v1 Advanced Mode analysis method

settings (continued)

Tab

Settings

Peak Detector

IMPORTANT! Laboratories need to perform the
appropriate internal validation studies to determine the
peak amplitude threshold (highlighted in red below) that
allows for reliable interpretation of SEfiler Plus data.

Analysis Method Editor - HID X
General | Allele Peak [ CTOV Peak Guality | Guality Flags
Pesk Detection Algorthm: (Advanced v
Ranges Peak Detection
Analysis Sizing Peak Ampltude Thresholds:
Pattial Range v Pattial Sizes v B: |50 R |50
Start Pt | 2500 Start Size:| 60
G |50 0: |50
Stop Pt | 10000 Stop Size: 400
¥ |50
rStmocthing ahd Baselining
i Wiy, Peak Half idth: 2 pts:
Emocthing ) hone 3
@ Light Polynomizl Degree;
O Heavy Peak Window Size: 135 pts
Baseline Window: 51 pts Slape Threshold
Peak Start: 00
rSize Calling Method ——————) Peak End: 0.0
O 2nd Crder Lesst Sguares
() 3rd Order Least Squares
O Cubic Spline Interpolation
(%) Local Southern Method
() Global Southern Method
Factory Defaults

The software uses the peak detection parameters to
specify the minimum peak height to limit the number of
peaks detected. Although GeneMapper ID software
displays peaks that occur below the specified amplitude
in electropherograms, the software does not label or
determine the genotype of these peaks.

IMPORTANT! When analyzing data generated on an
ABI Prism® 310 Genetic Analyzer running on a
Windows® NT platform, you may need to reduce the
Peak Window Size from 15 to 13 to facilitate detection of
each of the 1 bp microvariant alleles (21, 21.1, and 21.2)
included in the SE33 allelic ladder. Laboratories must
perform the appropriate internal validation studies to
determine the Peak Window Size value that allows for
reliable interpretation of SEfiler Plus™ Kit data when run
on an ABI PrISM® 310 Genetic Analyzer running on a

Windows® NT platform.
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Table 4-1

settings (continued)

SEfiler_Plus_HID_v1 Advanced Mode analysis method

Tab

Settings

Peak Detector
(continued)

Note: The analysis range is set by you based on
location of the primer peaks and the size standard peaks.

Note: For information on peak-detection algorithms,
refer to the GeneMapper ID Software v3.1 Human
Identification Analysis User Guide (PN 4338775),
Appendix A, and the Installation Procedures and New
Features for GeneMapper ID Software v3.2 User Bulletin

(PN 4352543).

Peak Quality

Analysis Method Editor - HID x)
General | Allels | Peak Detector ||
Sighal level
Homozygaus min peak height
Heterozygous min pesk height
Heterozygots balance
Min peak height ratic
Peak morphology
M peal widih (basepairs)
Pull-up pesk
’7Pu\l—up ratic
Alele number
Max expected alleles
Factory Defaults

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide



Chapter 4 Analyzing Data

Table 4-1 SEfiler_Plus_HID_v1 Advanced Mode analysis method
settings (continued)

Tab Settings
Quality Flags Analysis Method Editor - HID X
and PQV General | llele | Peak Detector | Peak qualty | Guity Fiags |
Thresholds

Quality weights are betwesn 0 and 1.
[ Guality Flag Setting:

Spectral Pull-up Cortrol Concordance

Eroad Peak Low Peak Height

Qut of Bin Allele Off-scals

= of =
w wlio

Qwerlag Peak Height Ratio

PG Threshold:

Pass Range: Loy Quality Range:
Sizing Qusity From ta 1.0 From0Oto 025 |
Genotyps Quality: Fram to 10 Fram 0.0t0 m

Factory Defaults

Importing an HID  The size standard for the AmpF{STR® SEfiler Plus™ PCR
Size Standard Amplification Kit uses the following GS600 peaks in its sizing
algorithm: 60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240,
250, 260, 280, 300, 314, 320, 340, 360, 380, and 400.

Use the following procedure to import the size standard for the
SEfiler Plus kit from the folder that you downloaded from the
Applied Biosystems web site, into the GeneMapper /D software
database. Refer to step 1a on page 4-4 for downloading instructions.

To import an HID Size Standard

1. Select Tools » GeneMapper Manager to open the
GeneMapper Manager.
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To import an HID Size Standard (continued)

2.

Import a Size Standard:
a. Select the Size Standards tab, then click Import.

Projects | Analysis Methods | Teble Settings | Plot Settings | Matrices | Size Standards

Mame Last Saved Owvner Type Descrigtion
377_G5_HD_GS500 2006-09-2014:10:2 | grmid Basicladvanced Factory Provided
377_F_HID_GS500 2006-09-2014:10:2 | grricd Basicladvanced Factory Provided
CE_G5_HD_G5500 2006-09-2014:10:2| grmicl BasziclAdvanced Factary Provided
CE_F_HID_GS500 2006-09-2014:10:2| grmicl BaziclAdvanced Factary Provided

< 1]

Mewy... open.. Save Az Expott... Delete

b. Navigate to, then open the GMID_SEfiler_Plus_files
folder.

Select CE_GS5_SEfiler_Plus_GS600_HID_v1, then click
Import to import the SEfiler_Plus_HID_v1 analysis method
into the GeneMapper /D database.

(#] Import Size Standard Method

Loak in: |&] GMID_SEfiler_Plus_files V| I ,3|| El
= o] Efiler P
,J SEfiler_Plus_HID_1
Recent
?'_'_'
L
Desktop
‘-j File name: | CE_G5_SEfiler_Plus_GSE00_HID_w1 xml |
My Documents | Files of type: |)(ML Files ¢* i) w | Cancel
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Analyzing and Editing Sample Files with
GeneMapper® ID Software

Analyzing

a Project 1. In the Project window, select File » Add Samples to

Project, then navigate to the disk or directory containing the
sample files.

2. | Apply analysis settings to the samples in the project.

Parameter Advanced Analysis Method

Sample Type Select the sample type.
Analysis Method | SEfiler_Plus_HID_v1

Panel AmpFLSTR_SEfiler_Plus_Panels_v1
Size Standard* | CE_G5_SEfiler_Plus_GS600_HID$

Matrix Select a matrix for 310 instruments only.

I For more information about how the Size Caller works, refer to the
ABI PrisM® GeneScan® Analysis Software for the Windows NT®
Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (PN 4335617).

§ The following fragments are defined for the CE_G5_HID_GS600
size standard provided with the AmpF(STR® SEfiler Plus kit:

60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260,
280, 300, 314, 320, 340, 360, 380, and 400. For additional
information about size standards, refer to the GeneMapper® ID
Software Version 3.1 Human Identification Analysis User Guide
(PN 4338775), Appendix D.

3. Click # (Analyze), enter a name for the project (in the Save
Project dialog), then click OK to start analysis.

» The status bar displays progress of analysis:

— As a completion bar extending to the right with the
percentage indicated

— With text messages on the left

* The table displays the row of the sample currently being
analyzed in green (or red if analysis failed for the
sample).

» The Genotypes tab becomes available after analysis.
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Concordance_Test - gmid Is Logaed In

< | >

Progress Status ..

File Edt Analysis Wew Tools Help

&f & B oE il B & Tablesetting  [concordance v\g BE8 =

= Sproject Samples | Genotypzs |

[91_2007-04- Status |Sample File Sample Name | Sample Type | Analysis Method Panel Size Standard EEEENE]
. _z007-04- | W [W_a0ifsa  [m Sample SEfler_Plus_HD_v1 | SEfier_Plus_v1 | CE_G5_SEfiler_Plus_GSS00_HD CRCEOE
2 W |W02E0iss |02 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD e
3 W [103COiizs (103 Sarmple SEfler_Flus_HD_wi | SEfler_Flus_wi | CE_G5_SEfier_Plus_GS600_HD e
4 W |104D0tza |10 Sarmple SEfler_Plus HD_wi | SEfler_Flus_wi |CE_G5_SEfier_Plus_GSB00_HD e
5 W |05E0Tfsa  [105 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD e
3 Wi |06F0Tfsa |10 Sample SEfler_Plus_HD_wi | SEfler_Plus_wi | CE_G5_SEfiler_Plus_GS600_HD e
7 W |108_ADifsa |10 Sarmple SEfler_Flus_HD_wi | SEfler_Flus_wi | CE_G5_SEfier_Plus_GS600_HD e
o W |W9B0Ziss |19 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD e
4 W |M0COZisa |10 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD e
10 (W 11 D0zfsa 111 Sarmple SEfler_Flus_HD_wi | SEfler_Flus_wi | CE_G5_SEfier_Plus_GS600_HD e
1 |W V202t (112 Sarmple SEfler_Flus_HD_wi | SEfler_Flus_wi | CE_G5_SEfier_Plus_GS600_HD e
12 | M3F02fsa (113 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD e
13 |y 114G02fsa (114 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_(G5_SEfiler_Plus_GS800_HD
16 | |dder_GOTisa lader Allelc Ladder | SEfler_Plus_HD vl |SEfiler_Plus w1 |CE_G5_SEfiler_Plus_GS600_HD
15 |Wg  1M5ADEf (115 Sample SEfler_Plus HD i |SEfier_Plus vl | CE_G5_SEfiler_Plus_GSB00_HD
16 | 16B0EGa (116 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD
17 | 17COafss (117 Sarmple SEfler_Plus_HD_w | SEfler_Flus_vi | CE_G5_SEfiler_Plus_GSB00_HD
1§ |W |11BD03fa (118 Sarmple SEfler_Flus_HD_wi | SEfler_Flus_wi | CE_G5_SEfier_Plus_GS600_HD
19 |y M9EDIfsa (119 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD
0 | 120F03fsa 120 Sample SEfler_Plus_HD_v1 | SEfier_Plus_vl | CE_G5_SEfiler_Plus_GS800_HD
2 | 1ZAMEa 122 Sarmple SEfler_Flus_HD_wi | SEfler_Flus_wi | CE_G5_SEfier_Plus_GS600_HD
2 g 123B04fsa 123 Sarmple SEfler_Plus HD_wi | SEfler_Flus_wi |CE_G5_SEfier_Plus_GSB00_HD
<

Figure 4-1

Project Window before analysis

For more information about any of these tasks, refer to the
GeneMapper® ID Software Version 3.1 Human Identification
Analysis User Guide (PN 4338775).
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Examining and  You can display electropherogram plots from the Samples and
Editing a Project  Genotypes tabs of the Project window to examine the data. These
procedures start with the Samples tab of the Project window
(assuming the analysis is complete).

For more information about any of these tasks, refer to:
* Installation Procedures and New Features for GeneMapper® ID

Software v3.2 User Bulletin (PN 4352543)

»  GeneMapper® ID Software Version 3.1 Human Identification
Analysis User Guide (PN 4338775)

» GeneMapper® ID Sofiware Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (PN 4335523)
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Chapter 5 Experiments and Results

Overview

Experiments
Using
AmpF(STR®

SEfiler Plus™ Kit

Importance of
Validation

Experiments

This chapter provides results of the developmental validation
experiments performed by Applied Biosystems using the
AmpF(STR® SEfiler Plus™ PCR Amplification Kit (SEfiler Plus
kit).

Validation of a DNA typing procedure for human identification
applications is an evaluation of the procedure's efficiency, reliability,
and performance characteristics. By challenging the procedure with
samples commonly encountered in forensic and parentage
laboratories, the validation process uncovers attributes and
limitations that are critical for sound data interpretation in casework
(Sparkes, Kimpton, Watson ef al., 1996; Sparkes, Kimpton, Gilbard
et al., 1996; and Wallin ef al., 1998).

Experiments to evaluate the performance of the AmpF¢STR® SEfiler
Plus™ PCR Amplification Kit were performed at

Applied Biosystems. These experiments were performed according
to the DNA Advisory Board (DAB) Quality Assurance Standards,
effective October 1, 1998 (DNA Advisory Board, 1998). The DAB
standards describe the quality assurance requirements that a
laboratory should follow to ensure the quality and integrity of the
data and competency of the laboratory.

Additional validation was performed according to the revised
guidelines from the Scientific Working Group on DNA Analysis
Methods (SWGDAM, July 10, 2003). Based on these guidelines,
Applied Biosystems has performed experiments that comply with
guidelines 1.0 and 2.0 and its associated subsections. This DNA
methodology is not novel (Moretti et al., 2001; Frank et al., 2001;
Wallin ef al., 2002; and Holt et al., 2000).

This chapter discusses many of the experiments performed by
Applied Biosystems and provides examples of results obtained.
Applied Biosystems chose conditions that produced maximum PCR
product yield and that met reproducible performance standards. It is
the opinion of Applied Biosystems that although these experiments
are not exhaustive, they are appropriate for a manufacturer.

IMPORTANT! Each laboratory using the AmpF(STR® SEfiler Plus™
PCR Amplification Kit must perform internal validation studies.

5-2
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Developmental Validation

SWGDAM  “Developmental validation is the demonstration of the accuracy,
Guideline 1.2.1 precision, and reproducibility of a procedure by the manufacturer,
technical organization, academic institution, government laboratory,
or other party.”” (SWGDAM, July 2003)

SWGDAM  “The reaction conditions needed to provide the required degree of
Guideline 2.10.1 specificity and robustness must be determined. These include
thermocycling parameters, the concentration of primers, magnesium
chloride, DNA polymerase, and other critical reagents.”
(SWGDAM, July 2003)

PCR Applied Biosystems examined the concentration of each component

Components  of the AmpF/(STR® SEfiler Plus™ PCR Amplification Kit. The
concentration for each individual component was established to be in
the window that meets the reproducible performance characteristics
of specificity and sensitivity. For example, various magnesium
chloride concentrations were tested on the Applied Biosystems
3130x/ Genetic Analyzer. The amplification of 0.50 ng of the control
DNA 007 is shown in Figure 5-1 on page 5-4. Applied Biosystems
observed that the performance of the multiplex is most robust within
a £20% window of magnesium chloride concentration.
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Figure 5-1 0.50 ng of control DNA 007 amplified with the
AmpF(STR® SEfiler Plus™ kit in the presence of varying
concentrations of magnesium chloride and analyzed on the
Applied Biosystems 3130x/ Genetic Analyzer

Thermal cycling parameters were established for amplification of the
SEfiler Plus kit. Thermal cycling times and temperatures of
GeneAmp® PCR systems were verified. Varying annealing and
denaturation temperature windows were tested to verify that a
specific PCR product with the desired sensitivity of at least 0.50 ng
of AmpF{STR® Control DNA 007 was produced.

For example, annealing temperatures were tested at 55, 57, 59, 61,
and 63 °C (Figure 5-2 on page 5-5) for 2-minute hold times in the
Silver 96-Well GeneAmp® PCR System 9700. The PCR products
were analyzed using the Applied Biosystems 3130x/ Genetic
Analyzer.
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Of the tested annealing temperatures, 55 to 61 °C produced robust
profiles. At 63 °C the yield of the majority of loci was significantly
reduced. Routine thermal cycler calibration is recommended when
you follow the amplification protocol. No preferential amplification
was observed at the standard annealing temperature of 59 °C.

100 200 300 400
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VAT R N O RO | R R I N

Figure 5-2 Electropherograms obtained from amplification of
0.50 ng of control DNA 007 at annealing temperatures of 55 °C,
57 °C, 59 °C, 61 °C, and 63 °C, analyzed on the Applied
Biosystems 3130x/ Genetic Analyzer, Y-axis scale

(0 to 4,000 RFUs)
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PCR Cycle
Number

SEfiler Plus kit reactions were amplified for 28, 29, 30, 31, and 32
cycles on the Silver 96-Well GeneAmp® PCR System 9700 using
0.50 ng from three DNA samples. As expected, the amount of PCR
product increased with the number of cycles. A full profile was
generated at 28 cycles and off-scale data were collected for several
allele peaks at 32 cycles (Figure 5-3).

Although none of the cycle numbers tested produced nonspecific
peaks, 30 cycles was found to give optimal sensitivity when the
amplified products were examined on Applied Biosystems 3130x/
Genetic Analyzers.
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28 cycles
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Figure 5-3 Representative AmpF(STR® SEfiler Plus™ kit profiles
obtained from ampilification of 0.50 ng DNA template using 28, 29,
30, 31, and 32 cycles, analyzed on the Applied Biosystems 3130x/
Genetic Analyzer, Y-axis scale (0 to 4,000 RFUs)
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Accuracy, Precision, and Reproducibility

SWGDAM  “The extent to which a given set of measurements of the same sample
Guideline 2.9 agree with their mean and the extent to which these measurements
match the actual values being measured should be determined.”
(SWGDAM, July 2003)

Accuracy Laser-induced fluorescence detection of length polymorphism at
short tandem repeat loci is not a novel methodology (Holt ef al.,
2000; and Wallin et al., 2002). However, accuracy and reproducibility
of AmpF(STR® SEfiler Plus™ PCR Amplification Kit profiles have
been determined from various sample types.

Figure 5-4 on page 5-8 shows the size differences that are typically
observed between sample alleles and allelic ladder alleles on the
Applied Biosystems 3130x/ Genetic Analyzer with POP-4™ polymer.
The x-axis in Figure 5-4 on page 5-8 represents the nominal
nucleotide sizes for the AmpF¢STR® SEfiler Plus™ Allelic Ladder.
The dashed lines parallel to the x-axis represent the +0.25-nt
windows. The y-axis represents the deviation of each sample allele
size from the corresponding allelic ladder allele size. All sample
alleles are within £0.5 nt from a corresponding allele in the allelic
ladder.
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Figure 5-4 Size deviation of 77 samples analyzed on the Applied
Biosystems 3130x/ Genetic Analyzer

Sizing precision allows for determining accurate and reliable
genotypes. Sizing precision was measured on the Applied
Biosystems 3130x/ Genetic Analyzer. The recommended method for
genotyping is to employ a +0.5-nt “window” around the size obtained
for each allele in the AmpF(STR® SEfiler Plus™ Allelic Ladder. A
+0.5-nt window allows for the detection and correct assignment of

alleles. Any sample allele that sizes outside the specified window
could be:

* An “off-ladder” allele, that is, an allele of a size that is not
represented in the AmpF(STR® SEfiler Plus™ Allelic Ladder

or

* An allele that does correspond to an allelic ladder allele, but
whose size is just outside a window because of measurement
error

5-8
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The measurement error inherent in any sizing method can be defined
by the degree of precision in sizing an allele multiple times. Precision
is measured by calculating the standard deviation in the size values
obtained for an allele that is run in several injections on a capillary
instrument or in several lanes of one gel.

Table 5-1 on page 5-10 shows typical precision results obtained from
five runs (16 capillaries/run) of the AmpF(STR® SEfiler Plus™
Allelic Ladder on the Applied Biosystems 3130x/ Genetic Analyzer
(36-cm capillary and POP-4™ polymer). The internal size standard
that was used was GeneScan'" 600 LIZ® Size Standard. The results
were obtained within a set of injections on a single capillary array.

Sample alleles may occasionally size outside the +0.5-nt window for
a respective allelic ladder allele because of measurement error. The
frequency of such an occurrence is lowest in detection systems
having the smallest standard deviations in sizing. Figure 5-4 on
page 5-8 illustrates the tight clustering of allele sizes obtained on the
Applied Biosystems 3130x/ Genetic Analyzer, where the standard
deviation in sizing is typically less than 0.15 nt. The instance of a
sample allele sizing outside of the £0.5-nt window because of
measurement error is relatively rare when the standard deviation in
sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a £0.5-nt window, the PCR
product must be rerun to distinguish between a true oft-ladder allele
versus measurement error of a sample allele that corresponds with an
allele in the allelic ladder. Repeat analysis, when necessary, provides
an added level of confidence to the final allele assignment.

The GeneMapper® ID software v3.2.1 automatically flags sample
alleles that do not size within the specified window around an allelic
ladder allele.

Although the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-
platform sizing differences arise from a number of parameters,
including type and concentration of polymer mixture, run
temperature, and electrophoresis conditions. Variations in sizing can
occur between runs on the same instrument and between runs on
different instruments because of these factors.

Applied Biosystems strongly recommends that the allele sizes be
compared to the sizes obtained for known alleles in the AmpF(STR®
SEfiler Plus™ Allelic Ladder from the same run and then be
converted to genotypes (as described in “Before You Start” on
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page 4-2.). See Table 5-1 for the results of five runs of the
AmpF(STR® SEfiler Plus™ Allelic Ladder. For more information on
precision and genotyping, see Lazaruk et al., 1998 and Mansfield et
al., 1998.

In Table 5-1, the mean size for all the alleles in each run (16
capillaries) was calculated. The mean range shown in the table is the
lowest and highest mean-size values of the five runs. Similarly, the
standard deviation for the allele sizing was calculated for all the
alleles in each run. The standard deviation range shown in Table 5-1
is the lowest and highest standard deviation values of the five runs.

Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
Amelogenin
X 102.16-102.18 0.028-0.034
Y 108.14-108.15 0.015-0.038
D16S539
5 227.25-227.29 0.027-0.047
8 239.36-239.42 0.034-0.044
9 243.51-243.56 0.027-0.045
10 247.63-247.69 0.029-0.042
11 251.67-251.74 0.026-0.043
12 255.63-255.69 0.029-0.045
13 259.56-259.63 0.024-0.041
14 263.57-263.63 0.031-0.045
15 267.59-267.64 0.027-0.041
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
D18S51
7 263.07-263.14 0.025-0.05
9 271.19-271.24 0.031-0.048
10 275.24-275.3 0.024-0.039
10.2 277.24-277.3 0.023-0.047
11 279.32-279.37 0.023-0.048
12 283.36-283.41 0.03-0.048
13 287.38-287.43 0.025-0.037
13.2 289.34-291.43 0.027-0.039
14 291.37-291.43 0.027-0.039
14.2 293.35-293.4 0.033-0.045
15 295.38-295.43 0.026-0.037
16 299.37-299.43 0.032-0.043
17 303.31-303.37 0.023-0.04
18 307.29-307.34 0.027-0.044
19 311.32-311.37 0.032-0.055
20 315.46-315.5 0.024-0.036
21 319.75-319.81 0.034-0.048
22 323.93-324 0.03-0.046
23 327.97-328.04 0.03-0.049
24 332.06-332.13 0.023-0.04
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Table 5-1 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
25 336.12-336.18 0.027-0.036
26 340.15-340.19 0.023-0.042
27 344.27-344.29 0.022-0.038

D19S433
9 99.6-99.68 0.03-0.05
10 103.76-103.85 0.04-0.044
11 107.9-107.97 0.03-0.045
12 111.99-112.06 0.029-0.053
12.2 114.03-114.11 0.024-0.039
13 115.97-116.06 0.029-0.036
13.2 117.96-118.04 0.027-0.044
14 119.89-119.98 0.034-0.045
14.2 121.87-121.95 0.033-0.045
15 123.8-123.9 0.033-0.039
15.2 125.79-125.9 0.03-0.04
16 127.76-127.86 0.03-0.044
16.2 129.75-129.86 0.027-0.047
17 131.72-131.83 0.035-0.057
17.2 133.72-133.84 0.034-0.044
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
D21S11
24 185.16-185.24 0.022-0.041
24.2 187.22-187.29 0.026-0.041
25 189.25-189.33 0.021-0.039
26 193.32-193.41 0.026-0.041
27 197.41-197.51 0.026-0.048
28 201.41-201.48 0.025-0.036
28.2 203.36-203.44 0.031-0.046
29 205.34-205.42 0.031-0.046
29.2 207.37-207.46 0.021-0.035
30 209.34-209.43 0.026-0.039
30.2 211.31-211.4 0.025-0.036
31 213.32-213.41 0.033-0.038
31.2 215.34-215.43 0.028-0.044
32 217.4-217.51 0.026-0.041
32.2 219.44-219.51 0.037-0.043
33 221.48-221.57 0.037-0.044
33.2 223.44-223.51 0.031-0.041
34 225.57-225.64 0.029-0.045
34.2 227.5-227.57 0.028-0.046
35 229.56-229.65 0.035-0.044
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Table 5-1 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
35.2 231.51-231.59 0.038-0.044
36 233.5-233.58 0.029-0.046
37 237.58-237.68 0.032-0.044
38 241.59-241.67 0.03-0.04
D2S1338
15 288.11-288.2 0.035-0.039
16 292.09-292.18 0.039-0.041
17 296.05-296.13 0.03-0.038
18 300-300.08 0.034-0.041
19 303.91-303.98 0.031-0.038
20 307.84-307.92 0.03-0.049
21 311.86-311.93 0.044-0.05
22 315.97-316.07 0.028-0.048
23 320.22-320.28 0.033-0.041
24 324.3-324.37 0.03-0.047
25 328.36-328.44 0.031-0.046
26 332.38-332.5 0.027-0.053
27 336.44-336.53 0.029-0.038
28 340.76-340.83 0.027-0.042
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
D3S1358
12 109.27-109.27 0.027-0.041
13 113.51-113.52 0.009-0.033
14 117.47-117.48 0.02-0.035
15 121.31-121.34 0.027-0.037
16 125.44-125.46 0.027-0.044
17 129.56-129.58 0.027-0.052
18 133.57-133.58 0.024-0.044
19 137.5-137.51 0.033-0.037
D8S1179
8 122.59-122.62 0.026-0.04
9 126.58-126.6 0.025-0.045
10 130.58-130.6 0.027-0.041
11 134.62-134.63 0.024-0.03
12 138.69-138.7 0.012-0.039
13 142.91-142.93 0.024-0.037
14 147.06-147.07 0.023-0.038
15 151.18-151.2 0.023-0.032
16 155.33-155.35 0.028-0.039
17 159.49-159.5 0.028-0.042
18 163.58-163.6 0.027-0.047
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Table 5-1 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
19 167.64-167.65 0.02-0.042
FGA
17 210.09-210.1 0.032-0.038
18 214.14-214.15 0.027-0.042
19 218.28-218.3 0.026-0.032
20 222.4-222.42 0.025-0.043
21 226.47-226.5 0.033-0.046
22 230.54-230.57 0.029-0.048
23 234.63-234.65 0.033-0.041
24 238.71-238.73 0.033-0.044
25 242.86-242.89 0.029-0.037
26 247.03-247.06 0.029-0.044
26.2 249.1-249.13 0.034-0.039
27 251.1-251.14 0.03-0.037
28 255.11-255.13 0.038-0.043
29 259.08-259.11 0.027-0.035
30 263.15-263.18 0.034-0.049
30.2 264.97-265 0.036-0.049
31.2 269.03-269.06 0.035-0.048
32.2 273.09-273.11 0.031-0.045
33.2 277.17-277.2 0.036-0.047
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
42.2 313.41-313.48 0.039-0.053
43.2 317.67-317.72 0.028-0.046
44.2 321.89-321.94 0.039-0.042
45.2 326.03-326.07 0.039-0.048
46.2 330.04-330.06 0.037-0.045
47.2 334.09-334.13 0.024-0.05
48.2 338.19-338.22 0.034-0.041
50.2 346.3-346.35 0.032-0.043
51.2 350.39-350.44 0.031-0.04
SE33
4.2 201.24-201.27 0.026-0.046
6.3 210.31-210.34 0.037-0.046
8 215.36-215.4 0.03-0.042
9 219.5-219.54 0.027-0.05
11 227.65-227.7 0.032-0.051
12 231.71-231.76 0.036-0.042
13 235.79-235.83 0.031-0.041
14 239.87-239.91 0.031-0.049
15 244.04-244.08 0.033-0.048
16 248.19-248.26 0.04-0.052
17 252.26-252.31 0.029-0.047

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide



Chapter 5 Experiments and Results

Table 5-1 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation

18 256.26-256.3 0.035-0.045

19 260.2-260.24 0.031-0.053

20 264.24-264.3 0.034-0.047
20.2 266.23-266.28 0.034-0.05

21 268.3-268.36 0.034-0.049
21.1 269.3-269.37 0.029-0.054
21.2 270.26-270.31 0.033-0.051
22.2 274.34-274.38 0.034-0.052
23.2 278.42-278.46 0.032-0.049
24.2 282.47-282.51 0.044-0.053
25.2 286.47-286.53 0.039-0.05
26.2 290.49-290.53 0.04-0.049
27.2 294.48-294.54 0.036-0.045
28.2 298.48-298.53 0.028-0.043
29.2 302.43-302.48 0.027-0.051
30.2 306.38-306.44 0.035-0.05
31.2 310.39-310.46 0.036-0.052
32.2 314.48-314.56 0.042-0.052
33.2 318.75-318.82 0.033-0.049
34.2 322.93-323 0.036-0.048
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
35 325.01-325.07 0.038-0.054
35.2 327.05-327.09 0.033-0.044
36 329.1-329.15 0.039-0.051
37 333.21-333.22 0.042-0.05
THO1
4 159.72-159.79 0.004-0.049
5 163.79-163.85 0.028-0.048
6 167.84-167.9 0.027-0.05
7 171.88-171.96 0.023-0.039
8 175.94-176 0.029-0.039
9 179.98-180.05 0.021-0.04
9.3 183.12-183.2 0.027-0.044
10 184.09-184.14 0.022-0.036
11 188.19-188.27 0.024-0.035
13.3 199.45-199.52 0.035-0.044
VWA
11 151.27-151.32 0.025-0.034
12 155.37-155.41 0.023-0.042
13 159.52-159.56 0.006-0.042
14 163.79-163.81 0.02-0.045
15 167.7-167.74 0.018-0.045
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® SEfiler Plus™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
16 171.76-171.8 0.025-0.045
17 175.8-175.84 0.025-0.031
18 179.81-179.85 0.024-0.045
19 183.9-183.95 0.026-0.043
20 187.99-188.04 0.029-0.045
21 192.05-192.08 0.016-0.037
22 196.12-196.16 0.026-0.035
23 200.09-200.13 0.027-0.047
24 204.4-204.45 0.024-0.036

5-20 AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide



Extra Peaks in the Electropherogram

Extra Peaks in the Electropherogram

Causes of Extra Peaks other than the target alleles may be detected on the
Peaks clectropherogram. Causes for extra peaks include stutter products,
incomplete 3" A nucleotide addition (at the n-1 position), dye
artifacts, and mixed DNA samples (see DAB Standard 8.1.2.2).

Stutter Products

A stutter is a well-characterized PCR artifact that refers to the
appearance of a minor peak that is one repeat unit smaller (or, less
frequently, one repeat unit larger) than the major STR product
(Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter
products at tetranucleotide STR loci has revealed that the stutter
product is missing a single tetranucleotide core repeat unit relative to
the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele
(percent stutter) is measured by dividing the height of the stutter peak
by the height of the main allele peak. Peak heights were measured for
amplified samples (n = 229) at the loci used in the AmpF(STR®
SEfiler Plus™ PCR Amplification Kit. All data were generated on the
Applied Biosystems 3130x/ Genetic Analyzer.

Some conclusions from these measurements and observations are:

» For each SEfiler Plus kit locus, the percent stutter generally
increases with allele length, as shown in Figure 5-5 to Figure 5-8
on pages 5-22 through 5-24.

+ Smaller alleles display a lower level of stutter relative to the
longer alleles within each locus.

» Each allele within a locus displays a percent stutter that is
consistent.

» The highest observed percent stutter for each locus is included
as the filtering step in the GeneMapper® ID software v3.2.1.
These values are shown in Table 5-2 on page 5-25. Peaks in the
stutter position that are above the highest observed percent
stutter are not filtered. Peaks in the stutter position that have not
been filtered and remain labeled can be further evaluated. For
evaluation of mixed samples, see Figure 5-17 on page 5-45.

» The measurement of percent stutter for peaks that are off-scale
may be unusually high.
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Table 5-2 Marker-specific stutter percentages (ratios used in
GeneMapper ID v3.2.1 AmpFLSTR_SEfilerPlus_panels_v1) for

SEfiler Plus Kit loci

Locus % Stutter
D21S11 12.22
D18S51 16.43
D19S433 12.64
THO1 5.77
FGA 18.23
D3S1358 13.07
VWA 11.63
D16S539 9.71
D2S1338 13.00
D8S1179 10.19
SE33 17.70

Addition of 3" A Nucleotide

Many DNA polymerases can catalyze the addition of a single
nucleotide (predominately adenosine) to the 3" ends of double-
stranded PCR products (Clark, 1988; Magnuson et al., 1996). This
nontemplate addition results in a PCR product that is one nucleotide
longer than the actual target sequence. The PCR product with the
extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of
the DNA at the 3" end of the PCR product. The SEfiler Plus kit
includes two design features that promote maximum +A addition:

* The primer sequences have been optimized to encourage +A

addition.

» The final extension step is 60 °C for 60 minutes.

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide
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This final extension step gives the DNA polymerase additional time
to complete +A addition to all double-stranded PCR products. STR

systems (where each allele is represented by two peaks that are one

nucleotide apart) that have not been optimized for +A addition may
have “split peaks.”

m 170 178 180 188 180 195
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el Mo Extension
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500_

500 +A

400 A
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300
200

100
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800 _|
200 | Final Extension
Foo_|
E00 _|
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Figure 5-9 Omitting the final extension step results in split peaks
due to incomplete A nucleotide addition. Data are from an
ABI PrisM® 310 Genetic Analyzer using another AmpF(STR® kit.
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Lack of complete +A nucleotide addition may be observed in SEfiler
Plus kit results when the amount of input DNA is greater than the
recommended protocols, because more time is needed for the enzyme
to add the +A nucleotide to all molecules as more PCR product is
generated. Amplification of too much input DNA may also result in
off-scale data.

Artifacts  Artifacts and anomalies are seen in all molecular biological systems.
Artifacts are typically reproducible. Anomalies are nonreproducible,
intermittent occurrences that are not consistently observed in a
system, for example, spikes and baseline noise. Artifacts have been
seen in data produced on genetic analyzers when using the SEfiler
Plus kit. Low-level artifacts in the calling region may appear in the
green (115 nt) and yellow (94 nt) dyes, depending on the sensitivity
of the instrument.

Figure 5-10 on page 5-28 and Figure 5-11 on page 5-29 show
examples of baseline noise and artifacts in an electropherogram while
using the SEfiler Plus kit. Genotyping may result in the detection of
these artifacts as off-ladder (OL) alleles. This occurs if the
recommended amount of input DNA is exceeded and off-scale data
are obtained. You should consider possible noise and artifacts when
interpreting data from the SEfiler Plus kit on the Applied Biosystems
3130/3130x/, ABI PrisM® 3100/3100-4vant, and ABI PRISM® 310
Genetic Analyzers.
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Figure 5-10 Examples of baseline noise and reproducible
artifacts in data produced on the Applied Biosystems 3130x/
Genetic Analyzer, Y-axis scale (0-50 RFUs)
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Figure 5-11 Examples of a -2 nt reproducible artifact in the SE33
locus. Data produced on the Applied Biosystems 3130x/ Genetic
Analyzer

Note that a high degree of magnification (y-axis) is used in
Figure 5-10 on page 5-28 and Figure 5-11 on page 5-29 to show the
artifacts.
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Characterization of Loci

SWGDAM
Guideline 2.1

Nature of the

Polymorphisms

Inheritance

“The basic characteristics of a genetic marker must be determined
and documented.” (SWGDAM, July 2003)

This section describes basic characteristics of the 11 loci and the sex-
determining marker, amelogenin, that are amplified with the
AmpF(STR® SEfiler Plus™ PCR Amplification Kit. These loci have
been extensively characterized by other laboratories.

The primers for the amelogenin locus flank a six-nucleotide deletion
within intron 1 of the X homologue. Amplification results in 107-nt
and 113-nt products from the X and Y chromosomes, respectively.
(Sizes are the actual nucleotide size according to sequencing results,
including 3" A nucleotide addition.) The remaining SEfiler Plus kit
loci, except the SE33 locus, are all tetranucleotide short tandem
repeat (STR) loci. The length differences among alleles of a
particular locus result from differences in the number of 4-nt repeat
units.

The SE33 locus is highly polymorphic. The SE33 locus not only
possesses structural variation, it also exhibits length and sequence
polymorphism (Mdller, Schurenkamp et al., 1995). Among the
sequence polymorphisms Type I contains the known regular four nt
repeat AAAG; while Type Il has an additional hexanucleotide unit,
AAAAAG. These result in additional interalleles in the SE33 locus
differing by 1 to 3 nt (Urquhart et al., 1993).

All the alleles in the AmpF(STR® SEfiler Plus™ Allelic Ladder,
including microvariants, have been subjected to DNA sequencing at
Applied Biosystems. In addition, other groups have sequenced alleles
at some of these loci (Nakahori et al., 1991; Puers et al., 1993;
Moller et al., 1994; Barber et al., 1995; Moller and Brinkmann, 1995;
Barber et al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998;
Momhinweg et al., 1998; Watson et al., 1998). Among the various
sources of sequence data on the AmpF{STR SEfiler Plus kit loci,
there is consensus on the repeat patterns and structure of the STRs.

The Centre d'Etude du Polymorphisme Humain (CEPH) has
collected DNA from families of Utah Mormon, French Venezuelan,
and Amish descent. These DNA sets have been extensively studied
all over the world and are routinely used to characterize the mode of
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inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and
several offspring. Consequently, the CEPH family DNA sets are ideal
for studying inheritance patterns (Begovich et al., 1992).

Because the oligonucleotide sequences between the SEfiler and
SEfiler Plus kits are identical, no changes in the pattern of
inheritance are reported.

Mapping The SEfiler Plus kit loci have been mapped, and the chromosomal
locations have been published (Nakahori et al., 1991; Edwards et al.,
1992; Kimpton et al., 1992; Mills et al., 1992; Sharma and Litt,
1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin, 1996).
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Species Specificity

Guideline 2.2

SWGDAM

“For techniques designed to type human DNA, the potential to detect
DNA from forensically relevant nonhuman species should be

evaluated.” (SWGDAM, July 2003)

The AmpF(STR® SEfiler Plus™ PCR Amplification Kit provides the

required specificity for detecting human alleles.

Nonhuman Studies

Nonhuman DNA may be present in forensic casework samples. The
data from SEfiler Plus kit experiments on nonhuman DNA sources

are shown in Figure 5-12.
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Figure 5-12 Representative electropherograms from a species-
specificity study including positive and non-template controls

(NTC)
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Figure 5-12 on page 5-32 shows amplification for: control DNA 007
(0.50 ng, panel 1), chimpanzee (0.50 ng, panel 2), dog (2.5 ng. panel
3), cat (2.5 ng, panel 4), horse (2.5 ng, panel 5), microbial DNA pool
(equivalent to 10° copies of Candida albicans, Neisseria
gonorrhoeae, E. coli 0157:H7, Bacillus subtilis, and Lactobacillus
rhamnosus, panel 6), and the negative control (panel 7). The
extracted DNA samples were amplified with the SEfiler Plus kit and
analyzed using the Applied Biosystems 3130x/ Genetic Analyzer.

* Primates: gorilla, chimpanzee, orangutan, and macaque (0.50 ng
each)

* Non-primates: mouse, dog, sheep, rabbit, cat, horse, hamster,
rat, chicken, and cow (2.5 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus,
Escherichia coli, Neisseria gonorrhoeae, Bacillus subtilis, and
Lactobacillus rhamnosus (equivalent to 10° copies)

The chimpanzee and gorilla DNA samples produced partial profiles
within the 70 to 283 nucleotide region.

The microorganisms, chicken, hamster, mouse, rabbit, and rat did not
yield detectable products. Dog, horse, sheep, and cow produced a
98-bp fragment near the amelogenin locus in the VIC® dye.
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Sensitivity

SWGDAM
Guideline 2.3

Importance of
Quantitation

Effect of DNA
Quantity on
Results

“When appropriate, the range of DNA quantities able to produce
reliable typing results should be determined.”
(SWGDAM, July 2003)

The optimal amount of input DNA added to the AmpF(STR® SEfiler
Plus™ PCR Amplification Kit should be between 0.50 and 0.75 ng.
The DNA sample should be quantitated before amplification using a
system such as the Quantifiler® Human DNA Quantification Kit
(PN 4343895). The final DNA concentration should be 0.05 to
0.075 ng/uL so that 0.50 to 0.75 ng of DNA is added to the PCR
reaction in a volume of 10 uL. If the sample contains degraded or
inhibited DNA, amplification of additional DNA may be beneficial.
In Figure 5-13 on page 5-35, the control DNA 007 was serially
diluted from 1 ng to 0.062 ng. Full profiles (24 PCR products) were
consistently obtained at 0.125 ng, but occasional partial profiles that
are missing anywhere from 1 to 3 alleles were observed at 0.062 ng.

If too much DNA is added to the PCR reaction, the increased amount
of PCR product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for
detection by the instrument (“off-scale” data)

Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not
accurate. For example, an allele peak that is off-scale can
cause the corresponding stutter peak to appear higher in
relative intensity, thus increasing the calculated percent
stutter.

— Multicomponent analysis of off-scale data is not accurate.
This inaccuracy results in poor spectral separation
(“pull-up™).

» Incomplete +A nucleotide addition
The sample can be reamplified using less DNA.

When the total number of allele copies added to the PCR is extremely
low, unbalanced amplification of the alleles may occur due to
stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate
minimum peak height threshold based on their own results and
instruments using low amounts of input DNA.
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Figure 5-13 Effect of amplifying 1 ng, 0.50 ng, 0.25 ng, 0.125 ng,
and 0.062 ng of control DNA 007

Note that the y-axis scale is magnified for the lower amounts of
DNA, analyzed using the Applied Biosystems 3130x/ Genetic
Analyzer.
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Stability

SWGDAM
Guideline 2.4

“The ability to obtain results from DNA recovered from biological
samples deposited on various substrates and subjected to various
environmental and chemical insults has been extensively
documented. In most instances, assessment of the effects of these
factors on new forensic DNA procedures is not required. However, if
substrates and/or environmental and/or chemical insults could
potentially affect the analytical process, then the process should be
evaluated using known samples to determine the effects of such
factors.” (SWGDAM, July 2003)

Degraded DNA

As the average size of degraded DNA approaches the size of the
target sequence, the amount of PCR product generated is reduced.
This is due to the reduced number of intact templates in the size
range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential
amplification of loci. High-molecular-weight Raji DNA was
sonicated and incubated with increasing doses of DNase I (0 to 6
Units) for 20 minutes (Bender ef al., 2004). The DNA was examined
by agarose gel analysis to determine the average size of the DNA
fragments at each time point.

One nanogram of degraded DNA was amplified using the
AmpF{STR SEfiler Plus Kit. As the DNA became increasingly
degraded, the loci became undetectable according to size. Preferential
amplification was not observed. The loci failed to robustly amplify in
the order of decreasing size as the extent of degradation progressed.
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Figure 5-14 Ampilification of Raji DNA samples sonicated and
incubated with increasing doses of DNase I. Panels 1, 2, 3, and 4
correspond to 0, 4, 5, and 6 units of DNase I.
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Effect of

Inhibitors —

Hematin

00

Heme compounds have been identified as PCR inhibitors in DNA
samples extracted from bloodstains (DeFranchis et al., 1988; Akane
et al., 1994). It is believed that the inhibitor is co-extracted and
co-purified with the DNA and subsequently interferes with PCR by
inhibiting polymerase activity.

To examine the effects of hematin on the amplification results
obtained by the SEfiler Plus kit, male DNA 007 (1 ng input DNA for
the SEfiler™ and SEfiler Plus™ kits) was amplified with increasing
concentrations of hematin for 30 cycles of amplification. The
concentrations of hematin used were 0 UM, 30 UM, 45 uM, and

55 uM (see Table 5-3).
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Figure 5-15 Amplification with AmpF(STR® SEfiler Plus™ and
SEfiler™ kits in the presence and absence of hematin. Panels 1
and 3 correspond to control samples; panels 2 and 4 correspond
to samples amplified in the presence of 45 UM of hematin.
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Comparison of SEfiler Plus™ and SEfiler™ kit performance in a
simulated model of hematin inhibition

Only those peaks >50 RFUs were counted. A complete profile with
control 007 DNA yields 24 peaks using the SEfiler Plus kit (see
Table 5-3).

Table 5-3 Comparison of SEfiler Plus™ and SEfiler™ kit
performance in simulated model of hematin inhibition (n = 3)

Hematin (uM) SEfiler Plus™ kit SEfiler™ kit
0 24/24, 24/24, 24/24 24/24, 24/24, 24/24
30 24/24, 24/24, 24/24 2/24, 2/24, 8/24
45 24/24, 21/24, 24/24 0/24, 0/24, 0/24
55 18/24, 23/24, 5/24 0/24, 0/24, 0/24
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Effect of
Inhibitors —
Humic Acid

Traces of humic acid may inhibit the PCR amplification of DNA
evidence collected from soil. In this study, Applied Biosystems tested
increasing amounts of humic acid in the PCR amplification of 1 ng of
control DNA 007 with the SEfiler and SEfiler Plus kits for 30 cycles
of amplification (see Figure 5-16). The concentrations of humic acid
tested were 0, 20, 40, and 60 ng/uL.

The SEfiler Plus kit efficiently amplified the DNA at concentrations
of humic acid that inhibited the amplification of DNA with the
SEfiler™ kit (see Figure 5-16 on page 5-40).
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Figure 5-16 Amplification with AmpF(STR® SEfiler Plus™ and
SEfiler™ kits in the presence and absence of humic acid. Panels 1
and 3 correspond to control samples; panels 2 and 4 correspond
to samples amplified in the presence of 20 ng/uL humic acid.

5-40

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide



Stability

Comparison of SEfiler Plus™ and SEfiler™ kit performance in a
simulated model of humic acid inhibition

Only those peaks >50 RFUs were counted. A complete profile with
control 007 DNA yields 24 peaks using the SEfiler Plus kit (see
Table 5-4).

Table 5-4 Comparison of SEfiler Plus™ and SEfiler™ kit
performance in simulated model of humic acid inhibition (n = 3)

"'“(:‘;‘;uf_;’id SEfiler Plus™ kit SEfiler™ kit
0 24/24,24/24,24/24 24/24,24/24,24/24
20 24/24,24/24,24/24 0/24, 0/24, 0/24
40 20/24,23/24, 24/24 0/24, 0/24, 0/24
60 9/24, 8/24,12/24 0/24, 0/24, 0/24
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Mixture Studies

SWGDAM
Guideline 2.8

Mixture Studies

“The ability to obtain reliable results from mixed source samples
should be determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual.
The possibility of multiple contributors should be considered when
interpreting the results. Applied Biosystems recommends that
individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to
avoid typing when stochastic effects are likely to interfere with
accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating
from more than one individual are an integral component of forensic
casework. Therefore, it is essential to ensure that the DNA typing
system is able to detect DNA mixtures. Mixed samples can be
distinguished from single-source samples by:

» The presence of more than two alleles at a locus

» The presence of a peak at a stutter position that is significantly
greater in percentage than what is typically observed in a single-
source sample

+ Significantly imbalanced alleles for a heterozygous genotype

5-42

AmpF&TR® SEfiler Plus™ PCR Amplification Kit User Guide



Mixture Studies

The peak height ratio is defined as the height of the lower peak (in
RFU) divided by the height of the higher peak (in RFU), expressed as
a percentage. Mean, median, minimum, and maximum peak height
ratios observed for alleles in the AmpF(STR® SEfiler Plus™ PCR
Amplification Kit loci in unmixed population database samples are
shown in Table 5-5:

Table 5-5 Peak height ratios for 0.50 ng of input DNA

Number of

Locus Obsel(':;ztions Mean | Median | Minimum | Maximum
Amelogenin 160 82.5 84.2 50.0 99.7
D16S539 170 84.1 86.7 50.9 99.6
D18S51 200 83.5 86.0 44.4 99.9
D19S433 185 83.3 84.1 55.9 99.9
D21S11 202 82.6 83.9 35.3 99.9
D2S1338 203 80.7 82.2 37.8 100.0
D3S1358 154 83.5 84.5 43.8 99.7
D8S1179 177 83.3 84.3 51.3 99.8
FGA 193 83.4 85.4 45.6 99.9
SE33 214 82.3 84.5 43.6 100.0
THO1 176 82.2 84.7 33.0 99.9
VWA 194 83.4 83.8 54.1 99.8

If an unusually low peak height ratio is observed for one locus, and
there are no other indications that the sample is a mixture, the sample
may be reamplified and reanalyzed to determine if the imbalance is
reproducible. Possible causes of imbalance at a locus are:

* Degraded DNA

* Presence of inhibitors

» Extremely low amounts of input DNA

* A mutation in one of the primer binding sites
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» Presence of an allele containing a rare sequence that does not
amplify as efficiently as the other allele

Resolution of Genotypes in Mixed Samples

A sample containing DNA from two sources can be comprised (at a
single locus) of any of the seven genotype combinations (see below).

» Heterozygote + heterozygote, no overlapping alleles
(four peaks)

» Heterozygote + heterozygote, one overlapping allele
(three peaks)

» Heterozygote + heterozygote, two overlapping alleles
two peaks)

» Heterozygote + homozygote, no overlapping alleles
(three peaks)

» Heterozygote + homozygote, overlapping allele
(two peaks)

* Homozygote + homozygote, no overlapping alleles
(two peaks)

» Homozygote + homozygote, overlapping allele
(one peak)

Specific genotype combinations and input DNA ratios of the samples
contained in a mixture determine whether or not it is possible to
resolve the genotypes of the major and minor component(s) at a
single locus.

The ability to obtain and compare quantitative values for the different
allele peak heights on Applied Biosystems instruments provides
additional valuable data to aid in resolving mixed genotypes. This
quantitative value is much less subjective than comparing relative
intensities of bands on a stained gel.

Ultimately, the likelihood that any sample is a mixture must be
determined by the analyst in the context of each particular case,
including the information provided from known reference sample(s).
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Figure 5-17 Amplification of DNA mixtures at various ratios

Limit of Detection of the Minor

Component

Mixtures of two DNA samples were examined at various ratios (0:1,

1:1, 3:1, 7:1, 15:1, 1:0). The tota
mixed at each ratio was 1 ng. Th

1 amount of genomic input DNA
e samples were amplified in a

GeneAmp® PCR System 9700, then electrophoresed and detected
using an Applied Biosystems 3130x/ Genetic Analyzer.

The results of the mixed DNA samples are shown in Figure 5-17 on
page 5-45, where samples A and B were mixed according to the
ratios provided. The minor component allele calls at non-overlapping
loci are highlighted. The amplification of the minor contributor at 3:1
and 7:1 (0.875:0.125 ng) mixture ratios was readily typeable. 15:1
ratios generally resulted in partial profiles for the minor component.
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Chapter 5 Experiments and Results

Table 5-6 shows the profiles of the samples in Figure 5-17 on
page 5-45.

Table 5-6 Genotypes of mixed DNA samples

Allele (EL‘ifi'riusSﬁK'go% Profile Sample B
D351358 15,16 15,18
VWA 14,16 14
D165539 9,10 12,13
D251338 20,23 20, 21
Amelogenin X, Y X, Y
D8S1179 12,13 14,15
SE33 17,252 18,28.2
D195433 14,15 12.2,14.2
THOA 7,93 6,9.3
FGA 24, 26 21,22
D21511 28, 31 28, 30
D18S51 12,15 17,19
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Population Data

SWGDAM  “The distribution of genetic markers in populations should be
Guideline 2.7 determined in relevant population groups.” (SWGDAM, July 2003)

Overview To interpret the significance of a match between genetically typed
samples, it is necessary to know the population distribution of alleles
at each locus in question. If the genotype of the relevant evidence
sample is different from the genotype of the suspect’s reference
sample, then the suspect is excluded as the donor of the biological
evidence tested. An exclusion is independent of the frequency of the
two genotypes in the population.

If the suspect and evidence samples have the same genotype, then the
suspect is included as a possible source of the evidence sample. The
probability that another, unrelated individual would also match the
evidence sample is estimated by the frequency of that genotype in the
relevant population(s).

The AmpF(STR® SEfiler Plus™ PCR Amplification Kit contains loci
for which extensive population data are available. For additional
information, see the population data and additional studies section of
the AmpFISTR® SEfiler™ PCR Amplification Kit User’s Manual

(PN 4323291).
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Mutation Rate

Estimating Estimation of spontaneous or induced germline mutation at genetic
Germline loci may be achieved through comparison of the genotypes of
Mutations offspring to those of their parents. From such comparisons, the
number of observed mutations are counted directly.

In previous studies, genotypes of 10 STR loci amplified by the
AmpF(STR® SGM Plus® PCR Amplification Kit were determined
for a total of 146 parent-offspring allelic transfers (meioses) at the
Forensic Science Service, Birmingham, England. One length-based
STR mutation was observed at the D18S11 locus; mutation was not
detected at any of the other nine STR loci. The D18S11 mutation was
represented by an increase of one 4-nt repeat unit, a 17 allele was
inherited as an 18 (single-step mutation). The maternal/paternal
source of this mutation could not be distinguished.

Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992;
Mutation Studies Weber and Wong, 1993; Hammond et al., 1994; Brinkmann ef al.,
1995; Chakraborty ef al., 1996; Chakraborty ef al., 1997; Brinkmann
et al., 1998; Momhinweg et al., 1998; Szibor et al., 1998) of direct
mutation rate counts produced:

» Larger sample sizes for some of the AmpF{STR SEfiler Plus kit
loci.

* Methods for modifications of these mutation rates (to infer
mutation rates indirectly for those loci where these rates are not
large enough to be measured directly and/or to account for those
events undetectable as Mendelian errors).
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Probability of Identity

Table of  Table 5-7 shows the Probability of Identity (PI) values of the
Probability of AmpF(STR® SEfiler Plus™ PCR Amplification Kit loci individually
Identity and combined.

Table 5-7  Probability of identity values for the AmpF(STR®
SEfiler Plus™ kit STR loci

Locus African-American U.S. Caucasian
D2S1338 0.025 0.038
D3S1358 0.114 0.099
D8S1179 0.079 0.072
D16S539 0.074 0.085
D18S51 0.038 0.056
D19S433 0.045 0.126
D21S11 0.051 0.057
FGA 0.034 0.044
SE33 0.019 0.02
THO1 0.103 0.119
vWA 0.067 0.077
Combined 6.47 x 10°1° 7.46 x 10714

The P, value is the probability that two individuals selected at random
will have an identical SEfiler Plus kit genotype (Sensabaugh, 1982).
The P; values for the populations described in this section are then
approximately 1/1.54 x 10'* (African-American) and 1/1.34 x 103
(U.S. Caucasian).
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Probability of Paternity Exclusion

Table of  Table 5-8 shows the Probability of Paternity Exclusion (Py) values of
Probability of  the AmpF(STR® SEfiler Plus™ PCR Amplification Kit STR loci
Paternity of individually and combined.

Exclusion Table 5-8 Probability of Paternity Exclusion values for the

AmpF(STR® SEfiler Plus™ kit STR loci

Locus African-American U.S. Caucasian
D2S1338 0.0745 0.621
D3S1358 0.734 0.65
D8S1179 0.477 0.763
D16S539 0.67 0.42
D18S51 0.725 0.912
D19S433 0.632 0.516
D21S11 0.745 0.734
FGA 0.784 0.676
SE33 0.745 0.792
THO1 0.578 0.734
VWA 0.613 0.705
Combined 0.999997 0.999998

The Py, value is the probability, averaged over all possible
mother-child pairs, that a random alleged father will be excluded
from paternity after DNA typing of the SEfiler Plus kit STR loci
(Chakraborty and Stivers, 1996).
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Troubleshooting

In This Appendix Follow the recommended actions for the observations described in
this appendix to understand and eliminate problems you experience
during analysis.

Troubleshooting. .. ........ ... .. .. .. ... A-2
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Appendix A Troubleshooting

Troubleshooting

Table A-1

Troubleshooting causes and recommended actions

Observation

Possible Causes

Recommended Actions

Faint or no signal from
both the AmpF(STR®
Control DNA 007 and
the DNA test samples
at all loci.

Incorrect volume or absence of
either AmpF(STR® SEfiler Plus™
Master Mix or AmpF(STR® SEfiler
Plus™ Primer Set

Repeat ampilification.

No activation of enzyme

Repeat ampilification, making sure to
hold reactions initially at 95 °C for
11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

AmpF(STR® SEfiler Plus™ Primer
Set exposed to too much light

Store Primer Set protected from
light.

GeneAmp® PCR System
malfunction

Refer to the thermal cycler user’s
manual and check instrument
calibration.

Incorrect thermal cycler
parameters

Check the protocol for correct
thermal cycler parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into
contact with block after first cycle.
Repeat test.

Wrong PCR reaction tube

Use Applied Biosystems MicroAmp
Reaction Tubes with Caps for the
GeneAmp 9700.

MicroAmp™ Base used with
tray/retainer set and tubes in
GeneAmp® System 9700

Remove MicroAmp Base from
tray/retainer set and repeat test.

A-2
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Troubleshooting

Table A-1 Troubleshooting causes and recommended actions (continued)

Observation

Possible Causes

Recommended Actions

Faint or no signal from
both the AmpF(STR®
Control DNA 007 and
the DNA test samples
at all loci. (continued)

Insufficient PCR product
electrokinetically injected

For ABI PrisM® 3100/3100-Avant or
Applied Biosystems 3130/3130x/
instrument runs:

Mix 1.0 pL of PCR product and 9 uL
of Hi-Di™ Formamide/GeneScan™
600 LIZ® solution.

AWARNlNG CHEMICAL

HAZARD. Formamide causes eye,
skin, and respiratory tract irritation.
It is a possible reproductive and
birth defect hazard. Read the
MSDS, and follow the handling
instructions. Wear appropriate
protective eyewear, clothing, and
gloves.

Degraded formamide

Check the storage of formamide; do
not thaw and refreeze multiple
times. Try Hi-Di™ Formamide.

AWARNlNG CHEMICAL

HAZARD. Formamide causes eye,
skin, and respiratory tract irritation.
It is a possible reproductive and
birth defect hazard. Read the
MSDS, and follow the handling
instructions. Wear appropriate
protective eyewear, clothing, and
gloves.
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Appendix A Troubleshooting

Table A-1

Troubleshooting causes and recommended actions (continued)

Observation

Possible Causes

Recommended Actions

Positive signal from
AmpF(STR® Control
DNA 007 but partial or
no signal from DNA
test samples

Quantity of test DNA sample is
below assay sensitivity

Quantitate DNA and add 0.5 to
0.75 ng of DNA. Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds,
certain dyes)

Quantitate DNA and add minimum
necessary volume. Repeat test.

Wash the sample in a
Centricon®-100 centrifugal filter
unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of
DNA sample by running an agarose
gel. If DNA is degraded, reamplify
with an increased amount of DNA.

Dilution of test sample DNA in H,O
or wrong buffer (for example,
wrong EDTA concentration)

Redilute DNA using TE Buffer (with
0.1 mM EDTA).

More than one allele
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid
introducing foreign DNA during
laboratory handling.

Too much DNA in reaction

Use recommended amount of
template DNA (0.5 to 0.75 ng).

Mixed sample

Amplification of stutter product
(n-4 nt position)

See “Stutter Products” on
page 5-21.

Incomplete 3" A base addition
(n-1 nt position)

See “Addition of 3" A Nucleotide” on
page 5-25. Be sure to include the
final extension step of 60 °C for

45 min in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Quantitate DNA and reamplify
sample, adding 0.5 to 0.75 ng of
DNA.

Poor spectral separation (bad
matrix)

Follow the steps for creating a
matrix file.

Confirm that Filter Set G5 modules
are installed and used for analysis.

A-4
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Troubleshooting

Table A-1

Troubleshooting causes and recommended actions (continued)

Observation

Possible Causes

Recommended Actions

Some but not all loci
visible on
electropherogram

Test-sample DNA is severely
degraded

If possible, evaluate the quality of
DNA sample by running an agarose
gel. If DNA is degraded, reamplify
with an increased amount of DNA.

Test sample contains high
concentrations of a PCR inhibitor
(for example, heme compounds,
certain dyes)

Quantitate DNA and add minimum
necessary volume. Repeat test.

Wash the sample in a Centricon-100
centrifugal filter unit.

Poor peak height
balance

Incorrect thermal cycler parameters.

Check the protocol for correct
thermal cycler parameters

GeneAmp PCR System 9700 with
Aluminum 96-Well block or third-
party thermal cyclers.

Use Applied Biosystems GeneAmp
PCR System 9700 with silver or
gold-plated silver blocks only.
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bin sets

importing  4-6

viewing 4-8
Bin view, displaying for a marker 4-8
biohazardous waste, handling ix
Bloodstained FTA Cards, amplification 2-10
bold text, when to use v

C

CAUTION, description vi
CEPH 5-30
characterization of loci, validation 5-30
chemical safety vii
chemical waste

hazards viii
chemical waste safety ix
chromosome location

locus designation  1-3

See Also allele; loci
contents of kit  1-12
control DNA

about 1-13

contents 1-12

storage 1-12
conventions

bold text v

for describing menu commands v

IMPORTANT! v

italic text v

Notes v

user attention words v
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customer feedback, on Applied Biosystems
documents  xii

cycle number, validation 5-6

D

D3S1358, locus designation  1-3
DANGER, description vi
data
accuracy, precision, and
reproducibility  5-7
artifacts  5-27
for different populations 5-47
data collection software 1-10
developmental validation 5-3

DNA
degraded 5-36
effect of quantity on result 5-34
effect of quantity, figure 5-35
methods for quantifying 2-5
mixture studies 5-42
mixture studies figure 5-44
negative control sample preparation 2-8
non-human specificity 5-32
positive control sample preparation 2-8
quantitation, importance of 5-34
sensitivity 5-34
stability 5-36
your sample preparation 2-8
DNA mixtures
amplification figure 5-45
limit of detection 5-45

documentation, related  xi

E

electropherogram
causes of extra peaks 5-10
extra peaks 5-21
species specificity 5-32
electrophoresis
data collection software 3-3, 3-7
preparing samples  3-5, 3-8
references 3-3, 3-7
run module 3-3, 3-7
setup 3-3,3-7

emission spectra 1-11

equipment, not included with kit 1-13
experiments and results  5-1

extra peaks, causes 5-21

F

FGA locus designation 1-3
fluorescent dyes 1-11

FTA card
DNA amplification using 2-10
figure showing results 2-10

G

GeneMapper ID software

allele tab 4-11

analysis settings 4-16

analyzing and editing sample files 4-16

considerations 4-2

description  4-2

general tab  4-10

peak detector tab  4-12

peak quality tab 4-13

quality flags tab 4-14

size standard 4-16

viewing imported panels 4-7
GeneMapper Manager 4-9, 4-14
GeneScan size standard

about 1-13

dye label 1-11

fragment sizes 4-16

volume per reaction 3-5, 3-8
guidelines

chemical safety vii

chemical waste disposal viii

chemical waste safety ix

H

hazards, chemical waste viii

hematin, effects of 5-38

HID analysis method, importing 4-9

Hi-Di formamide, volume per reaction 3-5,
3-8

humic acid, effect of 5-40
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Import Panels dialog box 4-4
IMPORTANT, description vi

Information Development department,
contacting  xii

inheritance  5-30
italic text, when touse v

marker, displaying Bin view of  4-8
master mix

contents 1-12

storage 1-12

volume per reaction 2-7

materials and equipment 1-12
materials, not included with kit 1-13

menu commands, conventions for
describing v

K mixed samples, resolution of genotypes 5-44
kit mixture studies 5-42
contents 1-12 MSDSs
description  1-2 description  vii
fluorescent dyes 1-11 obtaining vii
instruments for use with  1-2 multicomponent analysis  1-10
loci ampl.lﬁedl 112-3 mutation rate  5-48
;r:;:tﬁlrnr:ézr 12 mutation studies  5-48
primers  1-2, 1-12 mutation, STR  5-48
purpose 1-2
reagents 1-12 N
storage 1-12 Ny
thermal cyclers for use with  2-3 navigation pane
kit performance, comparison displaying list of panels ~ 4-7
DNase I figure 5-37 Panel Manager 4-4
hematin, figure 5-38
hematin, table 5-39 o
humic acid, figure  5-40 off-ladder alleles ~ 4-3, 5-8
humic acid, table = 5-41 operating systems 1-10, 3-3, 3-7
L | P
LIZailcz)ﬁtSta?filagd Panel Manager 4-4
volume per reaction 3-5, 3-8 panels, viewing  4-7
loci paternity exclusion 5-50
AmpFISTR SGM Plus  1-3 PCR
amplified 1-3 performing 2-9
characterization 5-30 setup 2-2
mapping 5-31 PCR components, validation of 5-3
low TE buffer, preparation 2-4 PCR cycle number, validation 5-6
PCR inhibitor
M hematin  5-38
. . . L humic acid 5-40
magnesium chloride concentration, validation
of 5.4 PCR work areas 2-2
peak detection parameters 4-12
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peak height ratios, table of alleles  5-42 species specificity 5-32

peak height, minimum 4-12 split peaks
percent stutter +A nucleotide addition 5-26
highest value for locus 5-21 figure 5-26
off-scale peaks 5-21 stability, DNA 5-36
relation to allele length  5-21 standards for samples  1-13
PQV thresholds  4-14 storage recommendations, kit 1-12
precision and size windows 5-8 stutter percent
precision, sizing 5-8 CSF1P0 and FGA loci  5-24
primers D13S317 and D7S820 loci  5-22
about 1-2 D16S539 and D18S51 loci  5-24
Amelogenin 5-30 D2S1338 and D21S11 loci  5-23
fluorescent dyes attached 1-12 for each kit locus  5-24
storage 1-12 marker specific 5-24
volume per reaction 2-7 stutter products  5-21
probability of identity 5-49
project window, figure 4-17 T
Technical Support, contacting  xii
Q thermal cyclers
quality flag settings 4-14 for use with kit 2-3
Quantifiler kit, description 2-6 programming  2-9
quantifying DNA, methods  2-5 thermal cycling parameters, validation of 5-4
training, information on  xii
R troubleshooting, causes and actions A-2
radioactive waste, handling ix U

reaction mix, for PCR 2-7
reaction volume, final for PCR  2-8
reactions, preparing for PCR  2-7

user attention words, described v

reagents V
low TE buffer 2-4 validation
not included with kit 1-13 annealing temperatures  5-4, 5-5
run module, electrophoresis  3-3, 3-7 characterization of loci  5-30
developmental 5-3
S effect of DNA quantity 5-34
experiments to evaluate 5-2
safety importance of 5-2
biological hazards x importance of DNA quantitation 5-34
chemical waste  viii magnesium chloride concentration  5-4
guidelines  vii, viii, ix mixture studies 5-42
size deviation, sample alleles and ladder mutation rate  5-48
alleles  5-8 PCR components 5-3
size standard, GeneMapper ID software 4-16 PCR cycle number  5-6

sizing precision  5-8 population data  5-47
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probability of identity 5-49
probability of paternity exclusion 5-50
sensitivity  5-34
size deviation, sample and ladder
alleles 5-8
species specificity 5-32
stability 5-36
thermal cycling parameters 5-4
vWA, locus designation 1-3

W

WARNING, description vi
waste disposal, guidelines ix

work area
amplified DNA 2-3
PCR setup 2-2

setup and lab design 2-2
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